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http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2 - UMFPACK Notice: The UMFPACK code was modified. Used by permission.
UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights
Reserved. UMFPACK License: Your use or distribution of UMFPACK or any modified version
of UMFPACK implies that you agree to this License. This library is free software; you can
redistribute it and/or modify it under the terms of the GNU Lesser General Public License
as published by the Free Software Foundation; either version 2.1 of the License, or (at
your option) any later version. This library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
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program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies. User documentation of any
code that uses this code or any modified version of this code must cite the Copyright, this
License, the Availability note, and "Used by permission." Permission to modify the code
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and to distribute modified code is granted, provided the Copyright, this License, and the
Availability note are retained, and a notice that the code was modified is included.
UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack  UMFPACK
(including versions 2.2.1 and earlier, in FORTRAN) is available at
http://www.cise.ufl.edu/research/sparse . MA38 is available in the Harwell Subroutine
Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at
http://www.cise.ufl.edu/research/sparse . COLAMD V2.0 is also incorporated as a built-in
function in MATLAB version 6.1, by The MathWorks, Inc. http://www.mathworks.com .
COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org ). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3
is a built-in routine in MATLAB 7.1.

Qt Version 4.6.3 - Qt Notice: The Qt code was modified. Used by permission. Qt copyright:
Qt Version 4.6.3, Copyright (c) 2010 by Nokia Corporation. All Rights Reserved. Qt
License: Your use or distribution of Qt or any modified version of Qt implies that you agree
to this License. This library is free software; you can redistribute it and/or modify it under
the
terms of the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version. This
library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies.User
documentation of any code that uses this code or any modified version of this code must
cite the Copyright, this License, the Availability note, and "Used by permission."
Permission to modify the code and to distribute modified code is granted, provided the
Copyright, this License, and the Availability note are retained, and a notice that the code
was modified is included. Qt Availability: http://www.qtsoftware.com/downloads  Patches
Applied to Qt can be found in the installation at:
$HPEESOF_DIR/prod/licenses/thirdparty/qt/patches. You may also contact Brian
Buchanan at Agilent Inc. at brian_buchanan@agilent.com for more information.

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property
rights in and to the source code, is owned by Hiroshima University and/or STARC.

Errata The ADS product may contain references to "HP" or "HPEESOF" such as in file
names and directory names. The business entity formerly known as "HP EEsof" is now part
of Agilent Technologies and is known as "Agilent EEsof". To avoid broken functionality and
to maintain backward compatibility for our customers, we did not change all the names
and labels that contain "HP" or "HPEESOF" references.

Warranty The material contained in this document is provided "as is", and is subject to
being changed, without notice, in future editions. Further, to the maximum extent
permitted by applicable law, Agilent disclaims all warranties, either express or implied,
with regard to this documentation and any information contained herein, including but not
limited to the implied warranties of merchantability and fitness for a particular purpose.
Agilent shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any
information contained herein. Should Agilent and the user have a separate written
agreement with warranty terms covering the material in this document that conflict with
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these terms, the warranty terms in the separate agreement shall control.

Technology Licenses The hardware and/or software described in this document are
furnished under a license and may be used or copied only in accordance with the terms of
such license. Portions of this product include the SystemC software licensed under Open
Source terms, which are available for download at http://systemc.org/ . This software is
redistributed by Agilent. The Contributors of the SystemC software provide this software
"as is" and offer no warranty of any kind, express or implied, including without limitation
warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be
liable for any damages of any kind including without limitation direct, indirect, special,
incidental and consequential damages, such as lost profits. Any provisions that differ from
this disclaimer are offered by Agilent only.

Restricted Rights Legend U.S. Government Restricted Rights. Software and technical
data rights granted to the federal government include only those rights customarily
provided to end user customers. Agilent provides this customary commercial license in
Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212
(Computer Software) and, for the Department of Defense, DFARS 252.227-7015
(Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial
Computer Software or Computer Software Documentation).

http://systemc.org/
http://systemc.org/
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 3GPP FDD Base Station Receiver Test
3GPPFDD_BS_RX is the test bench for 3GPP FDD base station receiver testing. The test
bench provides a way for users to connect to an RF circuit device under test and
determine its performance using pre-defined test bench measurements. This test bench
provides signal measurements for reference sensitivity level, dynamic range, adjacent
channel selectivity, and blocking and intermodulation characteristics.

The signal and the measurements are designed according to 3GPP Technical Specifications
TS 25.104 and TS 25.141. Versions supported are 2000-03, 2000-12, and 2002-03.

This 3GPP FDD signal model is compatible with Agilent E4438C ESG Vector Signal
Generator, Option 400 (3GPP W-CDMA Firmware Option for the E4438C ESG Vector Signal
Generator). Details regarding Agilent E4438C ESG are included at the website
http://www.agilent.com/find/esg .

This test bench includes a TX DSP section, an RF modulator, RF output source resistance,
an RF DUT connection, RF receivers, and DSP measurement blocks as illustrated in the
following figure. The generated test signal is sent to the DUT.

 

 Receiver Wireless Test Bench Block Diagram

 The 3GPPFDD_BS_RX test bench uses the uplink 12.2kbps reference measurement
channel. One 12.2kbps DTCH (dedicated transport channel) and one 2.4 kbps DCCH
(dedicated control channel) are multiplexed into one 60 kbps DPDCH (dedicated physical
data channel). The 60kbps DPDCH and 15kbps DPCCH (dedicated physical control
channel) are I/Q multiplexed into one data stream using different spread factors (64 for
DPDCH, 256 for DPCCH), then scrambled with the specified scrambling code. The
amplitude ratio of DPCCH/DPDCH is 0.7333 according to the TS25.104 Annex A. All
measurements provide BER results for DCCH and DTCH.

 

http://www.agilent.com/find/esg
http://www.agilent.com/find/esg
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 Test Bench Basics
A template is provided for this test bench.

 

 3GPPFDD Base Station Receiver Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose 3GPPFDD_BS_RX_test, click OK; click2.
left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click File >
Open > Example > WCDMA3G_RF_Verification_wrk > 3GPPFDD_BS_RX_test .

The basics for using the test bench are:

Connect to an RF DUT that is suitable for this test bench.
CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values
are typically accepted; if not, set values based on your requirements.
Activate/deactivate measurement(s) based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.

Open and use the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose 3GPPFDD_BS_RX_test , click OK ; click2.
left to place the template in the schematic window.

Test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For general information regarding using certain types of DUTs, see RF DUT
Limitations for 3GPP FDD Wireless Test Benches (adswtb3g).
 Set the Required Parameters .2.

Note
Refer to 3GPPFDD_BS_RX (adswtb3g) for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using Agilent ADS Ptolemy Data
Flow simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
The CE_TimeStep value is exported to the Choosing Analyses window in the
Circuit Envelope Time Step field when the user clicks OK in the Wireless Test
Bench Setup window.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings
WTB_TimeStep=1/(3.84e6 × 8) sec. The value is displayed in the Data Display
pages as TimeStep.

WTB_TimeStep = 1/(ChipRate × SamplesPerChip)

where

ChipRate is the non-settable value (3.84 MHz)
SamplesPerChip is the number of waveform sampling points during
pulse forming.

Set FSource, SourcePower, and FMeasurement.
FSource defines the RF frequency for the signal input to the RF DUT.
SourcePower defines the power level for FSource. SourcePower is defined
as the average power during the non-idle time of the signal.
FMeasurement defines the RF frequency output from the DUT to be
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measured.
MeasType specifies the type of measurement.
Pre-defined measurement settings (according to 3GPP specifications) are
provided for signal power, AWGN interference, CW interference, and modulated
interference.

Activate/deactivate ( YES / NO ) test bench measurements (refer to3.
3GPPFDD_BS_RX (adswtb3g) ). At least one measurement must be enabled.
More control of the test bench can be achieved by setting Basic Parameters , Signal4.
Parameters , and parameters for each activated measurement. For details refer to
Parameter Settings (adswtb3g).
The RF modulator (shown in the block diagram in Receiver Wireless Test Bench Block5.
Diagram) uses FSource, SourcePower ( Required Parameters ),
MirrorSourceSpectrum ( Basic Parameters) , GainImbalance, PhaseImbalance, I
OriginOffset, Q OriginOffset, and IQ Rotation ( Signal Parameters ).
The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic
Parameters ). The RF output signal source has a 50-ohm (default) output resistance
defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR. The RF signal has additive Gaussian noise power
set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The TX DSP block (shown in the block diagram in Receiver Wireless Test Bench Block
Diagram) uses other Signal Parameters.
 More control of Circuit Envelope analysis can be achieved by setting Envelope6.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
After running a simulation, results will appear in a Data Display window for the7.
measurement. Simulation Measurement Displays (adswtb3g) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 3GPPFDD_BS_RX 
This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 

Description 3GPP FDD BS RX test
Library WTB
Class TSDF3GPPFDD_BS_RX
Derived From baseWTB_RX

 Parameters

Name Description Default Sym Unit Type Range

RequiredParameters       

CE_TimeStep Circuit envelope simulation
time step

1/3.84 MHz/8  sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/3.84e6/SamplesPerChip.

SamplesPerChip is in
Signal Parameters tab.

    

FSource Source carrier frequency 1950 MHz  Hz real (0, ∞)

FMeasurement Measurement carrier
frequency

1950 MHz  Hz real (0, ∞)

MeasurementInfo Available Measurements
Each measurement has
parameters on its
tab/category below.

    

MeasType Measurement type:
RefLevel, DynamicRange,
ACS, Blocking, Intermod

RefLevel   enum  

BasicParameters       

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor
temperature

16.85  Celsius real [-273.15, ∞)

MeasR Measurement resistance 50 Ohm  Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO   enum  

MirrorMeasSpectrum Mirror meas spectrum
about carrier? NO, YES

NO   enum  

DUT_DelayBound DUT delay bound 10.0 usec  sec real [0,
(400.0/3840000)]

TestBenchSeed Random number generator
seed

1234567   int [0, ∞)

SignalParameters       
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GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0   real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0   real (-∞, ∞)

IQ_Rotation IQ rotation 0.0  deg real (-∞, ∞)

SamplesPerChip Samples per chip 8 S  int [2, 32]

RRC_FilterLength RRC filter chip length 16   int [1, 1000]

SpecVersion Secification version:
Version 03_00, Version
12_00, Version 03_02

Version 12_00   enum  

RefLevelParameters       

RefLevel_WantedSignalPower Wanted signal power:
dbmtow(-121) RefLevel

dbmtow(-121)
RefLevel

 W real
enum

(0, ∞)

DynamicRangeParameters       

DynamicRange_WantedSignalPower Wanted signal power:
dbmtow(-91)
DynamicRange

dbmtow(-91)
DynamicRange

 W real
enum

(0, ∞)

DynamicRange_AWGN_Density AWGN interference power
density: dbmtow(-
73)/(3.84MHz)
DynamicRange

dbmtow(-
73)/(3.84MHz)
DynamicRange

 W real
enum

(0, ∞)

ACS_Parameters       

ACS_WantedSignalPower Wanted signal power:
dbmtow(-115) ACS

dbmtow(-115)
ACS

 W real
enum

(0, ∞)

ACS_ModFreqOffset Modulated channel
frequency offset: plus
5MHz ACS, minus 5MHz
ACS

plus 5MHz
ACS

 Hz real
enum

(-∞, ∞)

ACS_ModPower Modulated channel power:
dbmtow(-52) ACS

dbmtow(-52)
ACS

 W real
enum

(0, ∞)

BlockingParameters       

Blocking_Info When
Blocking_ModFreqOffset is
+10 MHz / -10 MHz, the
recommended
SamplesPerChip (in Signal
Parameters Tab) is 16.
Also, set CE_TimeStep
equal to or less than the
value
1/3.84e6/SamplesPerChip.

    

Blocking_WantedSignalPower Wanted signal power:
dbmtow(-115) Blocking

dbmtow(-115)
Blocking

 W real
enum

(0, ∞)

Blocking_ModFreqOffset Modulated channel
frequency offset: plus
10MHz Blocking, minus
10MHz Blocking

plus 10MHz
Blocking

 Hz real
enum

(-∞, ∞)

Blocking_ModPower Modulated channel power:
dbmtow(-40) Blocking

dbmtow(-40)
Blocking

 W real
enum

(0, ∞)

IntermodParameters       

Intermod_Info When
Intermod_ModFreqOffset is
+20 MHz / -20 MHz, the
recommended
SamplesPerChip (in Signal
Parameters Tab) is 32.
Also, set CE_TimeStep
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equal to or less than the
value
1/3.84e6/SamplesPerChip.

Intermod_WantedSignalPower Wanted signal power:
dbmtow(-115) Intermod

dbmtow(-115)
Intermod

 W real
enum

[0, ∞)

Intermod_CW_FreqOffset Continuous wave
frequency offset: plus
10MHz Intermod_CW,
minus 10MHz
Intermod_CW

plus 10MHz
Intermod_CW

 Hz real
enum

(-∞, ∞)

Intermod_CW_Power Continuous wave power:
dbmtow(-48)
Intermod_CW

dbmtow(-48)
Intermod_CW

 W real
enum

(0, ∞)

Intermod_ModFreqOffset Modulated channel
frequency offset: plus
20MHz Intermod_Mod,
minus 20MHz
Intermod_Mod

plus 20MHz
Intermod_Mod

 Hz real
enum

(-∞, ∞)

Intermod_ModPower Modulated channel power:
dbmtow(-48)
Intermod_Mod

dbmtow(-48)
Intermod_Mod

 W real
enum

(0, ∞)

MeasurementParameters       

DisplayPages RX measurement display
pages:
3GPPFDD_BS_RX_test
Table
3GPPFDD_BS_RX_test
Equations

    

FrameSetsMeasured Sets of 4 frames measured 21   int [2, ∞]

RAKE_PathDelay Path delay for RAKE
(samples)

0   int [0, 2559]

 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed
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 Parameter Settings
More control of the test bench can be achieved by setting parameters on the Basic
Parameters, Signal Parameters, and measurements categories for the activated
measurements. Parameters for each category are described in the following sections.

Note
For required parameter information, see Set the Required Parameters. (adswtb3g).

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
MeasR defines the load resistance for the RF DUT output Meas signal into the test3.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the4.
generated RF signal before it is sent to the RF DUT. Depending on the configuration
and number of mixers in an RF transmitter, the signal at the input of the DUT may
need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in5.
RF signal input to the test bench (and output from the RF DUT). Depending on the
configuration and number of mixers in the RF DUT, the signal at its output may be
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and
measurement of the RF DUT output signal requires that its RF envelope is not
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for
measurements on the Meas_in signal in RX text benches and results in measurement
on a signal with no spectrum mirroring.
TestBenchSeed is an integer used to seed the random number generator used with6.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.
DUT_DelayBound is the maximum time delay introduced by the DUT.7.

  

 Signal Parameters

GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are1.
used to add certain impairments to the ideal output RF signal. Impairments are
added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:
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where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, Φ (in degrees) is the phase imbalance.
Next, the signal VRF( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and

Q_OriginOffset are then applied to the rotated signal. Note that the amounts
specified are percentages with respect to the output rms voltage. The output rms
voltage is given by sqrt(2 × SourceR × SourcePower).
SamplesPerChip is used to set the number of samples in a chip.2.
The default value is set to 8 to display settings according to the 3GPP standard. It
can be set to a larger value for a simulation frequency bandwidth wider than 8 ×
3.84 MHz. It can be set to a smaller value for faster simulation times; however, this
will result in lower signal fidelity. If SamplesPerChip = 8, the simulation RF bandwidth
is larger than the signal bandwidth by a factor of 8 (e.g., simulation RF bandwidth =
8 × 3.84 MHz).
RRC_FilterLength is used to set root raised-cosine (RRC) filter length in chips3.
The default value is set to 16 to transmit a 3GPP FDD uplink signal in time and
frequency domains based on the 3GPP standard [4]. It can be set to a smaller value
for faster simulation times; however, this will result in lower signal fidelity.
SpecVersion is used to specify the 3GPP specification versions 2000-03, 2000-12, or4.
2002-03.

  

 RefLevel Parameters

RefLevel_WantedSignalPower is the RF_out power for the reference sensitivity level test.
(MeasType = RefLevel)

  

 DynamicRange Parameters

DynamicRange_WantedSignalPower is the RF_out power for the dynamic range test.1.
(MeasType = DynamicRange)
DynamicRange_AWGN_Density is the interference additive white gaussian noise2.
signal power density.

  

 ACS Parameters

ACS_WantedSignalPower is the RF_out power for the adjacent channel selectivity1.
test. (MeasType = ACS)
ACS_ModFreqOffset is the modulated adjacent channel signal frequency offset from
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2.
the center frequency (FSource) of the assigned channel.
ACS_ModPower is modulated adjacent channel signal power.3.

  

 Blocking Parameters

Blocking_WantedSignalPower is the RF_out power for the blocking test. (MeasType =1.
Blocking)
Blocking_ModFreqOffset is the unwanted modulated signal frequency offset (other2.
than adjacent channel) from the center frequency (FSource) of the assigned channel.
Blocking_ModPower is the unwanted modulated signal power.3.

  

 Intermod Parameters

Intermod_WantedSignalPower is the RF_out power for the intermodulation test.1.
(MeasType = Intermod)
Intermod_CW_FreqOffset is the continuous wave frequency offset (un-modulated2.
signal) interference from the center frequency (FSource) of the assigned channel.
Intermod_CW_Power is the continuous wave interference power.3.
Intermod_ModFreqOffset is the unwanted modulated signal frequency offset from the4.
center frequency (FSource) of the assigned channel.
Intermod_ModPower is the unwanted modulated signal power.5.

  

 Measurement Parameters

DisplayPages provides Data Display page information for this measurement. It cannot1.
be changed by the user.
FrameSetsMeasured is the number of frame sets to be measured. One frame set2.
consists of four radio frames; one radio frame is 10 msec.
RAKE_PathDelay specifies the delay for the signal starting point. If3.
RAKE_PathDelay=0, the delay is automatically searched; if set to a non-zero integer,
the receiver uses this value for the signal starting point.
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 Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for each
measurement. Each Data Display includes tables and equations pages. Simulation results
include the BER of DTCH (dedicated transport channel), DCCH (dedicated control channel)
and DPDCH (dedicated physical data channel), and required parameters to set up the test
benches. Meas BER results are obtained by passing the signals through a DUT.

RF source power, RF source frequency, DUT output frequency, source output resistance,
and DUT output resistance are also displayed.

All tests require DTCH and DCCH BER performance, which cannot exceed 0.001.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for 3GPP FDD Wireless
Test Benches (adswtb3g).

 

 Reference Sensitivity Level

 The reference sensitivity level (defined in section 7.2 of TS25.104 [4]) is measured when
MeasType is set to RefLevel. Test conditions are:

BS Reference Sensitivity Level (dBm) BER

-121 dBm BER shall not exceed 0.001

The following figure shows reference sensitivity level test results.

 

 Reference Sensitivity Level Test Results

 

 Dynamic Range

 The dynamic range (defined in section 7.3 of TS25.104 [4]) is measured when MeasType
is set to DynamicRange. Test conditions are:
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Parameter Level Unit

Wanted signal -91 dBm

Interfering AWGN signal -73 dBm/3.84MHz

Dynamic Range Test Results shows the dynamic range test results.

 

 Dynamic Range Test Results

 

 Adjacent Channel Selectivity

 Adjacent channel sensitivity (defined in section 7.4 of TS25.104 [4]) is measured when
MeasType is set to ACS. Test conditions are:

Parameter Level Unit

Wanted signal -115 dBm

Interfering signal -52 dBm

Fuw (Modulated) 5 MHz

The interfering signal is a modulated uplink signal with 1 DPCCH + 1 DPDCH, where the
DPDCH rate is 960kbps. Fuw is the frequency offset of the modulated signal. The following
figure shows the adjacent channel sensitivity results.
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 Adjacent Channel Sensitivity Test Results

 

 Blocking Characteristics

 Blocking characteristics (defined in section 7.5 in TS25.104[4]) are tested when
MeasType is set to Blocking. Test conditions are:

Interfering Signal
Level

Wanted Signal
Level

Minimum Offset of Interfering
Signal

Type of Interfering
Signal

-40dBm -115dBm ±10MHz WCDMA signal with one
code

The following figure shows the blocking characteristics test results.

 

 Blocking Characteristics Test Results

 

 Intermodulation Characteristics

 Intermodulation characteristics (defined in section 7.6 in TS25.104[4]) are tested when
MeasType is set to Intermod. Test conditions are:

Interfering Signal Level Offset Type of Interfering Signal

-48 dBm ±10 MHz CW signal

-48 dBm ±20 MHz WCDMA signal with one code

In the RF channel, there are two intermodulation response signals that have a specific
frequency relationship to the requisite signal:

By default, the continuous wave interference has a +10 MHz frequency offset from
the central carrier frequency; its power is -48 dBm.
By default, the modulated interfering signal has a +20 MHz offset from the center
carrier frequency; its power is -48 dBm/3.84 MHz.
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The following figure shows intermodulation characteristics test results.

 

 Intermodulation Characteristics Test Results

 

 Test Bench Variables for Data Displays

 
The following table identifies the reference variables used to set up this test bench.

 Test Bench Equations Derived from Test Bench Parameters and Exported to the Data Display
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Data Display
Parameter

Equation with Test Bench Parameters

Spec_Version SpecVersion

RF_FSource FSource

RF_R SourceR

RF_SourceTemp SourceTemp

RF_Power_dBm 30 + 10 log(WantedSignalPower),
where WantedSignalPower = RefLevel_WantedSignalPower, or
DynamicRange_WantedSignalPower, or ACS_WantedSignalPower, or
Blocking_WantedSignalPower, or Intermod_WantedSignalPower, according to
MeasType setting.

ChipRate 3.84MChips/Second

SlotTime 0.667ms

FrameTime 10ms

TimeStep 1/(3.84e6*SamplesPerChip)

Meas_FMeasurement FMeasurement

Meas_R MeasR

FrameNum FramSetsMeasured * 4

AWGN_Density 30 + 10 log(DynamicRange_AWGN_Density),
when MeasType = DynamicRange

ModFreq FSource + ModFreqOffset,
where ModFreqOffset = ACS_ModFreqOffset, or Blocking_ModFreqOffset, or
Intermod_ModFreqOffset,
according to MeasType = ACS, Blocking, or Intermod.

ModePower_dBm 30 + 10 log (ModPower),
where ModPower = ACS_ModPower, or Blocking_ModPower or Intermod_ModPower,
according to MeasType = ACS, Blocking, or Intermod.

CWFreq FSource + Intermod_CW_FreqOffset,
when MeasType = Intermod

CWPower_dBm 30 + 10 log(Intermod_CW_Power),
when MeasType = Intermod
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
The number of time points in one slot can be calculated by SamplesPerChip
times ChipsPerSlot.
ChipRate = 3.84 MHz
SamplesPerChip = 8
ChipsPerSlot = 2560
1 FrameSet = 4 Frames
Resultant WTB_TimeStep = 32.6 nsec; SlotTime = 666.7 µ time points per slot
= 20480

Simulation times and memory requirements.
Measurement FrameSets Measured Simulation Time

(sec)
ADS Processes
(MB)

RefLevel 21 1858 105

DynamicRange 21 1941 106

ACS 21 2642 107

Blocking 21 2533 106

Intermod 21 2440 107

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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 3GPP FDD Base Station Transmitter
Test
3GPPFDD_BS_TX is the test bench for 3GPP FDD base station transmitter testing. The test
bench provides a way for users to connect to an RF circuit device under test and
determine its performance by activating various test bench measurements. This test
bench provides signal measurements for RF envelope, power (including CCDF), occupied
bandwidth, ACLR, code and peak code domain power, and EVM.

The signal and most of the measurements are designed according to the 3GPP Technical
Specification TS 25.141 and TS 25.104. Versions supported are 2000-03, 2000-12, and
2002-03.

This 3GPP FDD signal model is compatible with Agilent E4438C ESG Vector Signal
Generator, Option 400 (3GPP W-CDMA Firmware Option for the E4438C ESG Vector Signal
Generator). Details regarding Agilent E4438C ESG are included at the website
http://www.agilent.com/find/esg .

The DUT output signal can be sent to an Agilent ESG RF signal generator.

This test bench includes a DSP section, an RF modulator, RF output source resistance, RF
DUT connection, RF receivers, and DSP measurement blocks, as illustrated in the following
figure. The generated test signal is sent to the DUT.

 

 Transmitter Wireless Test Bench Block Diagram

In the 3GPP downlink signal frame structure, one frame has a duration of 10 msec and
consists of 15 slots; each slot contains 2560 chips; each chip is an RF signal symbol.

There is only one type of downlink dedicated physical channel, the downlink dedicated
physical channel (downlink DPCH). Within one downlink DPCH, dedicated data generated
at Layer 2 and above (i.e. the dedicated transport channel (DCH), is transmitted in time-
multiplex with control information generated at Layer 1). Layer 1 control information
consists of known pilot bits to support channel estimation for coherent detection, transmit
power-control (TPC) commands, and an optional transport-format combination indicator
(TFCI). The TFCI informs the receiver about the instantaneous transport format
combination of the transport channels mapped to the simultaneously transmitted downlink
DPCH radio frame.

http://www.agilent.com/find/esg
http://www.agilent.com/find/esg
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The downlink DPCH can therefore be seen as a time multiplex of a downlink DPDCH
(Data1 and Data2) and a downlink DPCCH (TPC, TFCI, and Pilot).

The frame and slot structure of the downlink DPCH is illustrated in the following figure.
(The following tables provide more information about each field.)

 

 3GPP FDD Downlink Frame and Slot Structure

 DPCH Structure for Test Model 1 and Test Model 2

Slot
Format No.

Channel Bit
Rate (kbps)

Channel Symbol
Rate (kbps)

SF Bits/Slot DPDCH
Bits/Slot

DPCCH Bits/Slot

NData1 NData2 NTFCI NTPC Npilot

10 60 30 128 40 6 24 0 2 8

 DPCH Structure for Test Model 3

Slot
Format No.

Channel Bit
Rate (kbps)

Channel Symbol
Rate (kbps)

SF Bits/Slot DPDCH
Bits/Slot

DPCCH Bits/Slot

NData1 NData2 NTFCI NTPC Npilot

6 30 15 256 20 2 8 0 2 8
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 Test Bench Basics
A template is provided for this test bench.

 

 3GPPFDD Base Station Transmitter Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose 3GPPFDD_BS_TX_test, click OK; click2.
left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click File >
Open > Example > WCDMA3G_RF_Verification_wrk > 3GPPFDD_BS_TX_test .

The basics for using the test bench are:

Connect to an RF DUT that is suitable for this test bench.
CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values
are typically accepted; if not, set values based on your requirements.
Activate/deactivate measurement(s) based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.

Open and use the template:

In an Analog/RF schematic window select Insert > Template .1.
In the Insert > Template dialog box, choose 3GPPFDD_BS_TX_test, click OK; click2.
left to place the template in the schematic window.

Test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For information regarding using certain types of DUTs, see RF DUT Limitations for
3GPP FDD Wireless Test Benches (adswtb3g).
Set the  Required Parameters2.

Note
Refer to 3GPPFDD_BS_TX (adswtb3g) for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using Agilent ADS Ptolemy Data
Flow simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep=approx. 32.6
nsec. The value is displayed in the Data Display pages as TimeStep.

WTB_TimeStep = 1/(ChipRate × SamplesPerChip)

where

ChipRate is the non-settable value (3.84 MHz)
SamplesPerChip is the number of waveform sampling points during
pulse forming.

Set FSource, SourcePower, and FMeasurement.
FSource defines the RF frequency for the signal input to the RF DUT.
SourcePower defines the power level for FSource. SourcePower is defined
as the average power during the non-idle time of the signal.
FMeasurement defines the RF frequency output from the DUT to be
measured.

Activate/deactivate ( YES / NO ) test bench measurements ( refer to3.
3GPPFDD_BS_TX (adswtb3g) ). At least one measurement must be enabled.
More control of the test bench can be achieved by setting Basic Parameters, Signal4.
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Parameters, and parameters for each activated measurement. For details refer to
Parameter Settings (adswtb3g).
The RF modulator (shown in the block diagram in Transmitter Wireless Test Bench5.
Block Diagram) uses FSource, SourcePower ( Required Parameters ),
MirrorSourceSpectrum ( Basic Parameters), GainImbalance, PhaseImbalance, I
OriginOffset, Q OriginOffset, and IQ Rotation ( Signal Parameters ).
The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic
Parameters ). The RF output signal source has a 50-ohm (default) output resistance
defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR. The RF signal has additive Gaussian noise power
set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The TX DSP block (shown in the block diagram in Transmitter Wireless Test Bench
Block Diagram) uses other Signal Parameters.
 More control of Circuit Envelope analysis can be achieved by setting Envelope6.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
 To send the RF DUT output signal to an Agilent ESG RF signal generator, set7.
parameters on the Signal to ESG tab.
For details, refer to Signal to ESG Parameters (adswtb3g).
After running a simulation, results will appear in a Data Display window for the8.
measurement. Simulation Measurement Displays (adswtb3g) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 3GPPFDD_BS_TX 
This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 

Description 3GPP FDD BS TX test
Library WTB
Class TSDF3GPPFDD_BS_TX
Derived From baseWTB_TX

 Parameters

Name Description Default Sym Unit Type Range

RequiredParameters       

CE_TimeStep Circuit envelope simulation
time step

1/3.84 MHz/8  sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/3.84e6/SamplesPerChip.

SamplesPerChip is in
Signal Parameters tab.

    

FSource Source carrier frequency 2140 MHz  Hz real (0, ∞)

SourcePower Source power dbmtow(-20.0)  W real [0, ∞)

FMeasurement Measurement carrier
frequency

2140 MHz  Hz real (0, ∞)

MeasurementInfo Available Measurements
Each measurement has
parameters on its
tab/category below.

    

RF_EnvelopeMeasurement Enable RF envelope
measurement? NO, YES

YES   enum  

PowerMeasurement Enable power
measurement? NO, YES

NO   enum  

ACLR_Measurement Enable ACLR
measurement? NO, YES

NO   enum  

OccupiedBW_Measurement Enable occupied bandwidth
measurement? NO, YES

NO   enum  

CDP_Measurement Enable code domain power
measurement? NO, YES

NO   enum  

PCDE_Measurement Enable peak code domain
error measurement? NO,
YES

NO   enum  

EVM_Measurement Enable EVM measurement?
NO, YES

NO   enum  

Basic
Parameters
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SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor
temperature

-273.15  Celsius real [-273.15, ∞)

EnableSourceNoise Enable source thermal
noise? NO, YES

NO   enum  

MeasR Measurement resistance 50 Ohm  Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO   enum  

MirrorMeasSpectrum Mirror meas spectrum
about carrier? NO, YES

NO   enum  

RF_MirrorFreq Mirror source frequency for
spectrum/envelope
measurement? NO, YES

NO   enum  

MeasMirrorFreq Mirror meas frequency for
spectrum/envelope
measurement? NO, YES

NO   enum  

DUT_DelayBound DUT delay bound 10.0 usec  sec real [0,
(400.0/3840000)]

TestBenchSeed Random number generator
seed

1234567   int [0, ∞)

Signal
Parameters

      

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0   real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0   real (-∞, ∞)

IQ_Rotation IQ rotation 0.0  deg real (-∞, ∞)

SamplesPerChip Samples per chip 8 S  int [2, 32]

RRC_FilterLength RRC filter length (chips) 16   int [1, ∞)

SpecVersion Secification version:
Version 03_00, Version
12_00, Version 03_02

Version 12_00   enum  

SourceType Source type:
TestModel1_16DPCHs,
TestModel1_32DPCHs,
TestModel1_64DPCHs,
TestModel2,
TestModel3_16DPCHs,
TestModel3_32DPCHs,
TestModel4

TestModel1_16DPCHs   enum  

RF_EnvelopeMeasurement
Parameters

      

RF_EnvelopeDisplayPages RF envelope measurement
display pages:
3GPPFDD_BS_TX Envelope
Figures

    

RF_EnvelopeStart RF envelope measurement
start

0.0  sec real [0, ∞)

RF_EnvelopeStop RF envelope measurement
stop

(2560/3.84) usec  sec real (0, ∞)

RF_EnvelopeSlots RF envelope measurement
slots

1   int [0, 100]

PowerMeasurement
Parameters

      

PowerDisplayPages Power measurement
display pages:
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3GPPFDD_BS_TX Power
Tables
3GPPFDD_BS_TX Power
Figures
3GPPFDD_BS_TX Power
Equations

PowerStartSlot Start slot 0   int [0, ∞)

PowerSlotsMeasured Slots measured 1   int [0, ∞)

ACLR_Measurement
Parameters

      

ACLR_DisplayPages ACLR measurement display
pages:
3GPPFDD_BS_TX ACLR
Tables
3GPPFDD_BS_TX ACLR
Figures
3GPPFDD_BS_TX ACLR
Equations

    

ACLR_Start Measurement start 0.0  sec real [0, ∞)

ACLR_Stop Measurement stop (2560/3.84) usec  sec real (0, ∞)

ACLR_Slots Measurement slots 0   int [0, 100]

ACLR_SpecMeasResBW Spectrum resolution
bandwidth

0  Hz real [0, ∞)

ACLR_SpecMeasWindow Window type: ACLR none,
ACLR Hamming 0.54, ACLR
Hanning 0.50, ACLR
Gaussian 0.75, ACLR
Kaiser 7.865, ACLR 8510
6.0, ACLR Blackman, ACLR
Blackman-Harris

ACLR none   enum  

OccupiedBW_Measurement
Parameters

      

OBW_DisplayPages Occupied BW measurement
display pages:
3GPPFDD_BS_TX OBW
Tables
3GPPFDD_BS_TX OBW
Figures
3GPPFDD_BS_TX OBW
Equations

    

OBW_Start Measurement start 0.0  sec real [0, ∞)

OBW_Stop Measurement stop (2560/3.84) usec  sec real (0, ∞)

OBW_Slots Measurement slots 0   int [0, 100]

OBW_SpecMeasResBW Spectrum resolution
bandwidth

0  Hz real [0, ∞)

OBW_SpecMeasWindow Window type: OBW none,
OBW Hamming 0.54, OBW
Hanning 0.50, OBW
Gaussian 0.75, OBW Kaiser
7.865, OBW 8510 6.0,
OBW Blackman, OBW
Blackman-Harris

OBW none   enum  

CDP_Measurement
Parameters

      

CDP_DisplayPages CDP measurement display
pages: 3GPPFDD_BS_TX
CDP Figures

    

CDP_StartSlot Start slot 0   int [0, ∞)
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PCDE_Measurement
Parameters

      

PCDE_DisplayPages PCDE measurement display
pages:
3GPPFDD_BS_TX PCDE
Tables
3GPPFDD_BS_TX PCDE
Figures
3GPPFDD_BS_TX PCDE
Equations

    

PCDE_StartSlot Start slot 0   int [0, ∞)

EVM_Measurement
Parameters

      

EVM_DisplayPages EVM measurement display
pages:
3GPPFDD_BS_TX EVM
Tables
3GPPFDD_BS_TX EVM
Equations

    

EVM_Start Measurement start 0.0  sec real [0, ∞)

EVM_SlotsMeasured Slots measured 1   int [1, ∞)

SignalToESG_
Parameters

      

EnableESG Enable signal to ESG? NO,
YES

NO   enum  

ESG_Instrument ESG instrument address [GPIB0::19::INSTR]
[localhost][4790]

  instrument  

ESG_Start Signal start 0  sec real [0, ∞)

ESG_Stop Signal stop (2560/3.84) usec  sec real [(ESG_Start+60/
3.84e6/S),
(ESG_Start+32/
3.84/S)]

ESG_Slots Slots to ESG 15   int [0, 1000]

ESG_Power ESG RF ouput power
(dBm)

-20.0   real (-∞, ∞)

ESG_ClkRef Waveform clock reference:
Internal, External

Internal   enum  

ESG_ExtClkRefFreq External clock reference
freq

10 MHz  Hz real (0, ∞)

ESG_IQFilter IQ filter: through,
filter_2100kHz,
filter_40MHz

through   enum  

ESG_SampleClkRate Sequencer sample clock
rate

30.72 MHz  Hz real (0, ∞)

ESG_Filename ESG waveform storage
filename

3GPPFDD_DL   string  

ESG_AutoScaling Activate auto scaling? NO,
YES

YES   enum  

ESG_ArbOn Select waveform and turn
ArbOn after download? NO,
YES

YES   enum  

ESG_RFPowOn Turn RF ON after
download? NO, YES

YES   enum  

ESG_EventMarkerType Event marker type:
Neither, Event1, Event2,
Both

Event1   enum  

ESG_MarkerLength ESG marker length 10   int [1, 60]
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 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed
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 Parameter Settings
More control of the test bench can be achieved by setting parameters on the Basic
Parameters, Signal Parameters, and measurements categories for the activated
measurements. Parameters for each category are described in the following sections.

Note
For required parameter information, see Set the Required Parameters (adswtb3g).

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
EnableSourceNoise, when set to NO disables the SourceTemp and effectively sets it3.
to -273.15oC (0 Kelvin). When set to YES, the noise density due to SourceTemp is
enabled.
MeasR defines the load resistance for the RF DUT output Meas signal into the test4.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the5.
generated RF signal before it is sent to the RF DUT. Depending on the configuration
and number of mixers in an RF transmitter, the signal at the input of the DUT may
need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in6.
RF signal input to the test bench (and output from the RF DUT). Depending on the
configuration and number of mixers in the RF DUT, the signal at its output may be
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and
measurement of the RF DUT output signal requires that its RF envelope is not
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for
measurements on the Meas_in signal in TX test benches (EVM, Constellation, CDP,
PCDE) and results in measurement on a signal with no spectrum mirroring.
TestBenchSeed is an integer used to seed the random number generator used with7.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.
RF_MirrorFreq is used to invert the polarity of the Q envelope in the RF_out RF signal8.
for RF envelope, ppectrum, ACLR, and occupied bandwidth measurements.
RF_MirrorFreq is typically set by the user to NO when MirrorSourceSpectrum = NO;
RF_MirrorFreq is typically set by the user to YES when MirrorSourceSpectrum = YES.
Both settings result in viewing the RF_out signal with no spectrum mirroring. Other
settings by the user result in RF_out signal for RF_Envelope and Spectrum
measurements with spectrum mirroring.
MeasMirrorFreq is used to invert the polarity of the Q envelope in the Meas_in RF9.
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signal for the RF envelope, spectrum, ACLR, and occupied bandwidth measurements.
MeasMirrorFreq is typically set to NO by the user when the combination of the
MirrorSourceSpectrum value and any signal mirroring in the users RF DUT results in
no spectrum mirroring in the Meas_in signal. MeasMirrorFreq is typically set to YES
by the user when the combination of the MirrorSourceSpectrum and RF DUT results
in spectrum mirroring in the Meas_in signal.
Other settings result in Meas_in signal for RF_Envelope and Spectrum measurements
with spectrum mirroring. The MirrorMeasSpectrum parameter setting has no impact
on the setting or use of the MeasMirrorFreq parameter.
DUT_DelayBound is used to transfer the DUT delay to measurements10.
synchronization. For measurements of RF_out before the DUT, an RF delay bound is
calculated by adding delays caused by RRC filters in modulation and measurements.
For measurements of RF DUT output (Meas_in), Meas delay bound is calculated by
adding DUT_DelayBound to RF delay bound.

  

 Signal Parameters

GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are1.
used to add certain impairments to the ideal output RF signal. Impairments are
added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, φ (in degrees) is the phase imbalance.
Next, the signal VRF ( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and

Q_OriginOffset are then applied to the rotated signal. Note that the amounts
specified are percentages with respect to the output rms voltage. The output rms
voltage is given by sqrt(2 × SourceR × SourcePower).
SamplesPerChip is used to set the number of samples in a chip. The default value is2.
set to 8 to display settings according to the 3GPP standard. It can be set to a larger
value for a simulation frequency bandwidth wider than 8 × 3.84 MHz. It can be set to
a smaller value for faster simulation; however, this will result in lower signal fidelity.
If SamplesPerChip = 8, the simulation RF bandwidth is larger than the signal
bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8 × 3.84 MHz).
RRC_FilterLength is used to set root raised-cosine (RRC) filter length in number of3.
chips. The default value is set to 16 to transmit a 3GPP FDD downlink signal in time
and frequency domains based on the 3GPP standard [4]. It can be set to a smaller
value for faster simulation times; however, this will result in lower signal fidelity.
Better Adjacent Channel Leakage Ratio (ACLR) can be obtained using a longer filter
length. Increasing RRC_FilterLength to 24 or 32 should result in a better ACLR. This
may also correlate better to ACLR measurements when using instruments from
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Agilent Technologies.
SpecVersion is used to specify the 3GPP specification versions (2000-03, 2000-124.
and 2002-03).
SourceType is used to specify the type of baseband signal. This source can generate5.
7 types of baseband signals [5]: TestModel1_16DPCHs, TestModel1_32DPCHs,
TestModel1_64DPCHs, TestModel2, TestModel3_16DPCHs, TestModel3_32DPCHs, and
TestModel4

Test Model 1 Active Channels lists the active channels of Test Model 1, which is
used to test spectrum emission mask, ACLR, spurious emissions, transmit
intermodulation, and base station maximum output power.
Test Model 2 Active Channels lists the active channels in Test Model 2, which is
used to test output power dynamics.
Test Model 3 Active Channels lists the active channels of Test Model 3, which is
used to test peak code domain error.
Test Model 4 Active Channels lists the active channels of Test Model 4, which is
used to test EVM.
 

 Test Model 1 Active Channels

Type Number of
Channels

Fraction of
Power (%)

Level
Setting
(dB)

Channelization
Code

Timing Offset
(x256Tchip)

PCCPCH+SCH 1 10 -10 1 0

Primary CPICH 1 10 -10 0 0

PICH 1 1.6 -18 16 120

SCCPCH containing
PCH (SF=256)†

1 1.6 -18 3 0

DPCH (SF=128) 16/32/64 76.8 total see [5] see [5] see [5]

† SCCPCH containing PCH is not included in versions 2000-03 and 2000-12 [5].

 

 Test Model 2 Active Channels

Type Number of
Channels

Fraction of
Power (%)

Level
Setting
(dB)

Channelization
Code

Timing Offset
(x256Tchip )

PCCPCH+SCH 1 10 -10 1 0

Primary CPICH 1 10 -10 0 0

PICH 1 5 -13 16 120

S-CCPCH
containing PCH
(SF=256)

1 5 -13 3 0

DPCH (SF=128) 3 2 x 10,1 x
50

2 x -10, 1
x -3

24, 72, 120 1, 7, 2

† SCCPCH containing PCH is not included in versions 2000-03 and +2000-12+[5]

 

 Test Model 3 Active Channels
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Type Number of
Channels

Fraction of
Power (%)
16/32

Level
Settings
(dB) 16/32

Channelization
Code

Timing Offset
(x256Tchip)

PCCPCH+SCH 1 12.6/7.9 -9 / -11 1 0

Primary CPICH 1 12.6/7.9 -9 / -11 0 0

PICH 1 5/1.6 -13 / -18 16 120

SCCPCH
containing PCH
(SF=256) †

1 5/1.6 -13 / -18 3 0

DPCH (SF=256) 16/32 63,7/80,4
total

see
Reference
[5]

see Reference
[5]

see Reference
[5]

† SCCPCH containing PCH is not included in versions 2000-03 and 2000-12 [5]

 

 Test Model 4 Active Channels

Type Number of
Channels

Fraction of
Power (%)
16/32

Level
Settings
(dB) 16/32

Channelization
Code

Timing Offset
(x256Tchip)

PCCPCH+SCH
when Primary
CPICH is disabled

1 50 to 1.6 -3 to -18 1 0

PCCPCH+SCH
when Primary
CPICH is enabled

1 25 to 0.8 -6 to -21 1 0

Primary CPICH† 1 25 to 0.8 -6 to -21 0 0

† Primary CPICH is optional; it is not included in versions 2000-03 and 2000-12 [5]

  

 RF Envelope Measurement Parameters

This measurement is not affected by the MirrorMeasSpectrum parameter. To apply
spectrum mirroring to the measured RF_out signal, set RF_MirrorFreq = YES. To apply
spectrum mirroring to the measured Meas_in signal, set MeasMirrorFreq = YES.

RF_EnvelopeDisplayPages provides Data Display page information for this1.
measurement. It cannot be changed by the user.
RF_EnvelopeStart sets the start time for collecting input data.2.
RF_EnvelopeStop sets the stop time for collecting input data when RF_EnvelopeSlots3.
= 0.
RF_EnvelopeSlots (when > 0) sets the number of slots over which data will be4.
collected.

Depending on the values of RF_EnvelopeStart, RF_EnvelopeStop, and RF_EnvelopeSlots,
the stop time may be adjusted.

For RF envelope measurement for both the RF_out and Meas_in signals:

Let:
Start = TimeStep × (int(RF_EnvelopeStart/TimeStep) + 0.5)
Stop = TimeStep × (int(RF_EnvelopeStop/TimeStep) + 0.5)



Advanced Design System 2011.01 - 3GPP FDD Wireless Test Benches

38

This means Start and Stop are forced to be an integer number of time-step
intervals.

RF_EnvelopeSlots Resultant Stop Time

0 Stop

> 0 Start + RF_EnvelopeSlots x SlotTime

For the RF envelope of Meas_in to contain at least one complete slot, the Stop value
should be set to a minimum of SlotTime + (RF DUT time delay).

For information about TimeStep and SlotTime, see Test Bench Variables for Data Displays.

  

 Power Measurement Parameters

PowerDisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
PowerStartSlot sets the number of slots which should be ignored.2.
PowerSlotsMeasured sets the number of slots over which data will be collected.3.

The measurement start time is PowerStartSlot × SlotTime. The measurement stop time is
(PowerStartSlot + PowerSlotsMeasured) × SlotTime. SlotTime is defined in Test Bench
Variables for Data Displays.

  

 ACLR Measurement Parameters

The ACLR measurement is implemented by the spectrum measurement, which measures
the RF signal spectrum in different frequency offsets. The ACLR can be calculated by
analyzing the spectrum measurement in the data display file.

In the following, TimeStep denotes the simulation time step, and FMeasurement denotes
the measured RF signal characterization frequency.

The measurement outputs the complex amplitude voltage values at the frequencies1.
of the spectral tones. It does not output power at frequencies of the spectral tones.
However, one can calculate and display the power spectrum as well as the magnitude
and phase spectrum by using the dBm, mag, and phase functions of the data display
window.
Note that the dBm function assumes a 50-ohm reference resistance; if a different
measurement was used in the test bench, its value can be specified as a second
argument to the dBm function, for example, dBm(SpecMeas, Meas_RefR) where
SpecMeas is the instance name of the spectrum measurement and Meas_RefR is the
resistive load used.
By default, the displayed spectrum extends from FMeasurement - 1/(2TimeStep) Hz
to FMeasurement + 1/(2TimeStep) Hz. When FMeasurement < 1/(2TimeStep), the
default spectrum extends to negative frequencies. The spectral content at these
negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. This way, the negative frequency tones are displayed
on the positive frequency axis as would happen in an RF spectrum analyzer
measurement instrument. This process may introduce an error in the displayed
frequency for the mirrored tones. The absolute error introduced is less than
(spectrum frequency step) / 2 (see the following table for the definition of spectrum
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frequency step).
The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple slots and average the results to achieve
video averaging (see note 6).
ACLR_DisplayPages provides Data Display page information for this measurement. It2.
cannot be changed by the user.
ACLR_Start sets the start time for collecting input data.3.
ACLR_Stop sets the stop time for collecting input data when ACLR_Slots = 0 and4.
ACLR_SpecMeasResBW = 0.
ACLR_Slots (when > 0) sets the number of slots over which data will be collected.5.
ACLR_SpecMeasResBW (when > 0) sets the resolution bandwidth of the spectrum6.
measurement.
Depending on the values of ACLR_Stop, ACLR_Slots, and ACLR_SpecMeasResBW, the
stop time may be adjusted and/or spectrum video averaging may occur. The different
cases are explained in the following table.
Referring to the following table let:

Start = TimeStep × int((ACLR_Start/TimeStep) + 0.5)
Stop = TimeStep × int((ACLR_Stop/TimeStep) + 0.5)
(This means Start and Stop are forced to be an integer number of time step
intervals.)
X be the Normalized Equivalent Noise BW of the window used

Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular
filter. It is the equivalent width of a rectangular filter that passes the same amount of
white noise as the window. The normalized ENBW is the ENBW multiplied by the time
duration of the signal being windowed. See Window Options and Normalized
Equivalent Noise Bandwidth for the normalized ENBW for the different window
options available.
The Start and Stop times are used for both the RF_out and Meas_in signal spectrum
analyses. The Meas_in signal is delayed in time from the RF_out signal by the value
of the RF DUT time delay. Thus for RF DUT time delay > 0, the RF_out and Meas_in
signal are inherently different and some spectrum display difference in the two is
expected.
TimeStep and SlotTime are defined in Test Bench Variables for Data Displays.

 Effect of Different Values for ACLR_Stop, ACLR_Slots, and ACLR_SpecMeasResBW
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Case
1

ACLR_Slots = 0
ACLR_SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case
2

ACLR_Slots > 0 ACLR_SpecMeasResBW = 0
Resultant stop time = Start + ACLR_Slots x SlotTime
Notes: For ACLR_Slots > 0 and ACLR_SpecMeasResBW = 0
Video averaging occurs over all slot time intervals
Resultant resolution BW = X/SlotTime
Resultant spectrum frequency step = 1/SlotTime
Video averaging status = Yes, when ACLR_Slots > 1

Case
3

ACLR_Slots = 0ACLR_Slots = 0
ACLR_SpecMeasResBW > 0
Resultant stop time = Start + N*SlotTimeInterval
where
N = int((Stop -Start)/SlotTimeInterval) + 1
For ACLR_Slots = 0 and ACLR_SpecMeasResBW > 0
Define SlotTimeInterval = TimeStep * int((X/(ACLR_SpecMeasResBW*TimeStep)) + 0.5)
This means SlotTimeInterval is forced to a value that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number (N) of SlotTimeInterval
N has a minimum value of 1
Video averaging occurs over all SlotTimeInterval
The resolution bandwidth achieved is ResBW = X / SlotTimeInterval, which is very close to
ACLR_SpecMeasResBW but may not be exactly the same if X/(ACLR_SpecMeasResBW*TimeStep)
is not an exact integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case
4

ACLR_Slots > 0
ACLR_SpecMeasResBW > 0
Resultant stop time = Start + M*SlotTimeInterval
where
M = int((ACLR_Slots x SlotTime)/SlotTimeInterval) + 1
For ACLR_Slots > 0 and ACLR_SpecMeasResBW > 0
Define SlotTimeInterval = TimeStep * int((X/(ACLR_SpecMeasResBW*TimeStep)) + 0.5)
This means SlotTimeInterval is forced to a value that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number (M) of the SlotTimeInterval
M has a minimum value of 1
Video averaging occurs over all SlotTimeIntervals
The resolution bandwidth achieved is ResBW = X / SlotTimeInterval, which is very close to
ACLR_SpecMeasResBW but may not be exactly the same if X/(ACLR_SpecMeasResBW*TimeStep)
is not an exact integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1

ACLR_SpecMeasWindow specifies the window that will be applied to each slot before7.
its spectrum is calculated. Different windows have different properties, affect the
resolution bandwidth achieved, and affect spectral shape. Windowing is often
necessary in transform-based (chirp-Z, FFT) spectrum estimation in order to reduce
spectral distortion due to discontinuous or non-harmonic signal over the
measurement time interval. Without windowing, the estimated spectrum may suffer
from spectral leakage that can cause misleading measurements or masking of weak
signal spectral detail by spurious artifacts.
The windowing of a signal in time has the effect of changing its power. The spectrum
measurement compensates for this and the spectrum is normalized so that the power
contained in it is the same as the power of the input signal.
Window Type Definitions:

none
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where N is the window size
Hamming 0.54

where N is the window size
Hanning 0.50

where N is the window size
Gaussian 0.75

where N is the window size
Kaiser 7.865

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
8510 6.0 (Kaiser 6.0)

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
Blackman

where N is the window size
Blackman-Harris
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where N is the window size.

 Window Options and Normalized Equivalent Noise Bandwidth

Window and Default Constant NENBW

none 1

Hamming 0.54 1.363

Hanning 0.50 1.5

Gaussian 0.75 1.883

Kaiser 7.865 1.653

8510 6.0 1.467

Blackman 1.727

Blackman-Harris 2.021

  

 OBW Measurement Parameters

The occupied bandwidth measurement is implemented by the spectrum measurement
which measures the spectrum of the input signal. The occupied bandwidth is calculated by
analyzing the spectrum measured in data display files.

In the following notes, TimeStep denotes the simulation time step, and FMeasurement
denotes the measured RF signal characterization frequency.

OBW_DisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
The measurement outputs the complex amplitude voltage values at spectral tone2.
frequencies.
Spectral tone frequency power is not output; however, power, magnitude, and phase
spectrums can be calculated and displayed by using the dBm, mag, and phase
functions of the data display window. Note that the dBm function assumes a 50-ohm
measurement reference resistance; if a different measurement is used in the test
bench, its value can be specified as a second argument to the dBm function; for
example, dBm(SpecMeas, Meas_RefR), where SpecMeas is the instance name of the
spectrum measurement and Meas_RefR is the resistive load.
By default, the displayed spectrum extends from FMeasurement - 1/(2TimeStep) Hz
to FMeasurement + 1/(2TimeStep) Hz. When FMeasurement < 1/(2TimeStep), the
default spectrum extends to negative frequencies. The spectral content at these
negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. This way, the negative frequency tones are displayed
on the positive frequency axis as would happen in an RF spectrum analyzer
measurement instrument. This process may introduce an error in the displayed
frequency for the mirrored tones. The absolute error introduced is less than
(spectrum frequency step) / 2 (see the following table for the definition of spectrum
frequency step).
The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple slots and average the results to achieve
video averaging (see note 6).
OBW_Start sets the start time for collecting input data.3.
OBW_Stop sets the stop time for collecting input data when OBW_Slots = 0 and4.
OBW_SpecMeasResBW = 0.
OBW_Slots (when > 0) sets the number of slots over which data will be collected.5.
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OBW_SpecMeasResBW (when > 0) sets the resolution bandwidth of the spectrum6.
measurement.
Depending on the values of OBW_Stop, OBW_Slots, and OBW_SpecMeasResBW, the
stop time may be adjusted and/or spectrum video averaging may occur. The different
cases are explained in the following table.
Let:

Start = TimeStep × int((OBW_Start/TimeStep) + 0.5)
Stop = TimeStep × int((OBW_Stop/TimeStep) + 0.5)
(This means Start and Stop are forced to be an integer number of time step
intervals.)
X be the Normalized Equivalent Noise BW of the window used

Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular
filter. It is the equivalent width of a rectangular filter that passes the same amount of
white noise as the window. The normalized ENBW is the ENBW multiplied by the time
duration of the signal being windowed. See Window Options and Normalized
Equivalent Noise Bandwidth for the normalized ENBW for the different window
options.
The Start and Stop times are used for both the RF_out and Meas_in signal spectrum
analyses. The Meas_in signal is delayed in time from the RF_out signal by the value
of the RF DUT time delay. Thus for RF DUT time delay > 0, the RF_out and Meas_in
signal are inherently different and some spectrum display difference in the two is
expected.
TimeStep and SlotTime are defined in Test Bench Variables for Data Displays.

 Effect of Different Values for OBW_Stop, OBW_Slots, and OBW_SpecMeasResBW
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Case
1

OBW_Slots = 0
OBW_SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case
2

OBW_Slots > 0
OBW_SpecMeasResBW = 0
Resultant stop time = Start + OBW_Slots x SlotTime
For OBW_Slots > 0 and OBW_SpecMeasResBW = 0
Video averaging occurs over all slot time intervals
Resultant resolution BW = X/SlotTime
Resultant spectrum frequency step = 1/SlotTime
Video averaging status = Yes, when OBW_Slots > 1

Case
3

OBW_Slots = 0
OBW_SpecMeasResBW > 0
Resultant stop time = Start + N*SlotTimeInterval
where
N = int((Stop -Start)/SlotTimeInterval) + 1
For OBW_Slots = 0 and OBW_SpecMeasResBW > 0
Define SlotTimeInterval = TimeStep * int((X/(OBW_SpecMeasResBW*TimeStep)) + 0.5)
This means SlotTimeInterval is forced to a value that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number (N) of SlotTimeInterval
N has a minimum value of 1
Video averaging occurs over all SlotTimeInterval
The resolution bandwidth achieved is ResBW = X / SlotTimeInterval, which is very close to
OBW_SpecMeasResBW but may not be exactly the same if X/(OBW_SpecMeasResBW*TimeStep)
is not an exact integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case
4

OBW_Slots > 0
OBW_SpecMeasResBW > 0
Resultant stop time = Start + M*SlotTimeInterval
where
M = int((OBW_Slots x SlotTime)/SlotTimeInterval) + 1
For OBW_Slots > 0 and OBW_SpecMeasResBW > 0
Define SlotTimeInterval = TimeStep * int((X/(OBW_SpecMeasResBW*TimeStep)) + 0.5)
This means SlotTimeInterval is forced to a value that is an integer number of time step intervals.
(Stop-Start) time is forced to be an integer number (M) of the SlotTimeInterval
M has a minimum value of 1
Video averaging occurs over all SlotTimeInterval
The resolution bandwidth achieved is ResBW = X / SlotTimeInterval, which is very close to
OBW_SpecMeasResBW but may not be exactly the same if X/(OBW_SpecMeasResBW*TimeStep)
is not an exact integer.
Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1

OBW_SpecMeasWindow sets the window that can be used. Different windows have7.
different properties, affect the resolution bandwidth achieved, and affect spectral
shape. The OBW_SpecMeasWindow is used to define the window that will be applied
to each slot before its spectrum is calculated. Windowing is often necessary in
transform-based (chirp-Z, FFT) spectrum estimation in order to reduce spectral
distortion due to discontinuous or non-harmonic signal over the measurement time
interval. Without windowing, the estimated spectrum may suffer from spectral
leakage that can cause misleading measurements or masking of weak signal spectral
detail by spurious artifacts.
The windowing of a signal in time has the effect of changing its power. The spectrum
measurement compensates for this and the spectrum is normalized so that the power
contained in it is the same as the power of the input signal.
Window Type Definitions:
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none

where N is the window size
Hamming 0.54

where N is the window size
Hanning 0.50

where N is the window size
Gaussian 0.75

where N is the window size
Kaiser 7.865

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
8510 6.0 (Kaiser 6.0)

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
Blackman

where N is the window size
Blackman-Harris
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where N is the window size.

 Window Options and Normalized Equivalent Noise Bandwidth

Window and Default Constant NENBW

none 1

Hamming 0.54 1.363

Hanning 0.50 1.5

Gaussian 0.75 1.883

Kaiser 7.865 1.653

8510 6.0 1.467

Blackman 1.727

Blackman-Harris 2.021

  

 CDP Measurement Parameters

CDP_DisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
CDP_StartSlot sets starting slot from which data will be collected. CDP_StartSlot is2.
used for RF_out and Meas_in CDP analyses.

The measurement interval is one timeslot. The length of time that data will be collected is
SlotTime (Test Bench Equations Derived from Test Bench Parameters and Exported to
Data Display describes SlotTime).

  

 PCDE Measurement Parameters

PCDE_DisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
PCDE_StartSlot sets the starting slot from which data will be collected.2.
PCDE_StartSlot is used for RF_out and Meas_in PCDE analyses.

The measurement interval is one timeslot. The length of time that data will be collected is
SlotTime (Test Bench Equations Derived from Test Bench Parameters and Exported to
Data Display describes SlotTime).

  

 EVM Measurement Parameters

EVM_DisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
EVM_Start specifies starting time instant for the measurement. EVM_Start time is2.
used for RF_out and Meas_in EVM analyses. The Meas_in signal is delayed in time
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from the RF_out signal by the RF DUT time delay value. Thus for RF DUT time delay
>0, RF_out and Meas_in signals are inherently different and some EVM difference in
the two is expected even if the RF DUT does not introduce any distortion other than
time delay.
EVM_SlotsMeasured specifies the measurement interval. The time length of data to3.
be collected is EVM_SlotMeasured× SlotTime (Test Bench Equations Derived from
Test Bench Parameters and Exported to Data Display describes SlotTime).

  

 Signal to ESG Parameters

The EVM measurement collects data from the Meas_in signal and downloads it to an
Agilent E4438C Vector Signal Generator. This measurement uses Connection Manager
architecture to communicate with the instrument; parameters specify how data is
interpreted.

Prerequisites for using the Signal to ESG option are:

ESG Vector Signal Generator E4438C; for information, visit the web site
http://www.agilent.com/find/esg .
PC workstation running an instance of the connection manager server.
Supported method of connecting the instrument to your computer through the
Connection Manager architecture; for information, see Connection Manager.

 

 Parameter Information

EnableESG specifies if the signal is downloaded to the ESG instrument. If set to NO,1.
no attempt will be made to communicate with the instrument.
ESG_Instrument specifies a triplet that identifies the VSA resource of the instrument2.
to be used in the simulation, the connection manager server hostname (defaults to
localhost ), and the port at which the connection manager server listens for incoming
requests (defaults to 4790). To ensure that this field is populated correctly, click
Select Instrument, enter the server hostname and port, click OK to see the Remote
Instrument Explorer dialog, select a VSA resource identifier, and click OK. For details
about selecting instruments, see Instrument Discovery in the Wireless Test Bench
Simulation documentation.
ESG_Start and ESG_Stop (when ESG_Slots=0) specify when to start and stop data3.
collection. The number of samples collected, ESG_Stop - ESG_Start + 1, must be in
the range 60 samples to 64 Msamples, where 1 Msample = 1,048,576 samples. The
ESG requires an even number of samples; the last sample will be discarded if
ESG_Stop - ESG_Start + 1 is odd.
ESG_Slots sets the number of slots over which data will be collected. When4.
ESG_Slots > 0, ESG_Stop is forced to ESG_Start + ESG_Slots x SlotTime (where
SlotTime is 5 msec).
ESG_ClkRef specifies an internal or external reference for the ESG clock generator. If5.
set to External, the ESG_ExtClkRefFreq parameter sets the frequency of this clock.
ESG_IQFilter specifies the cutoff frequency for the reconstruction filter that lies6.
between the DAC output and the Dual Arbitrary Waveform Generator output inside
the ESG.
ESG_SampleClkRate sets the sample clock rate for the DAC output.7.
ESG_FileName sets the name of the waveform inside the ESG that will hold the8.
downloaded data.

http://www.agilent.com/find/esg
http://www.agilent.com/find/esg
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The ESG driver expects data in the range {-1, 1}. ESG_AutoScaling specifies whether9.
to scale inputs to fit this range. If set to YES, inputs are scaled to the range {-1, 1};
if set to NO, raw simulation data is downloaded to the ESG without any scaling, but
data outside the range {-1, 1} is clipped to -1 or 1. If set to YES, scaling is also
applied to data written to the local file (ESG_FileName setting).
If ESG_ArbOn is set to YES, the ESG will start generating the signal immediately after10.
simulation data is downloaded; if set to NO, waveform generation must be turned on
at the ESG front panel.
If ESG_RFPowOn is set to YES, the ESG will turn RF power on immediately after11.
simulation data is downloaded. If ESG_RFPowOn is set to NO (default), RF power
must be turned on at the ESG front panel.
ESG_EventMarkerType specifies which ESG Event markers are enabled: Event1,12.
Event2, Both, or Neither. Event markers are used for synchronizing other instruments
to the ESG. When one or both EventMarkers are enabled, Event1 and/or Event2 is set
beginning from the first sample of the downloaded Arb waveform over the range of
points specified by the ESG_MarkerLength parameter. This is equivalent to setting
the corresponding event from the front panel of the ESG.
ESG_MarkerLength specifies the range of points over which the markers must be set13.
starting from the first point of the waveform. Depending on the setting of
ESG_EventMarkerType, the length of trigger Event1 or Event2 (or both) is set to a
multiple of the pulsewidth that, in turn, is determined by the sample clock rate of the
DAC output.
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 Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for each
measurement activated.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for 3GPP FDD Wireless
Test Benches (adswtb3g).

 

 RF Envelope Measurement

The RF Envelope measurement  (not defined in 3GPP specifications) measures the RF
signal at the input of the RF DUT, and the Meas signal at the output of the RF DUT. Test
Model 4 is used. The following figure shows the results.

The DUT delay (also displayed) is calculated by comparing the markers on the waveforms
of RF_out (before DUT) and Meas_in (after DUT).

 

 RF Envelope Measurement Results

 

 Power Measurement

 The power measurement (not defined in 3GPP specifications) shows transmitter CCDF
curves. The CCDF and peak-to-average ratio of RF_out signal before the DUT and the
Meas_in signal after the DUT are measured.
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Test Model 1 is used. The following figure shows the mean power, peak power and peak-
to-mean ratio of the signals.

 

 Signal Ratios

The following figure shows the CCDF curves.

 

 CCDF Curves

 

 ACLR Measurement

 The adjacent channel leakage power ratio (ACLR) measurement is defined in 3GPP TS
25.104, section 6.6.2.2. Test Model 1 is used.

ACLR is the ratio of the transmitted power to the power measured in an adjacent channel.
Both the transmitted and the adjacent channel power are measured through a matched
filter (root raised cosine and roll-off 0.22) with a noise power bandwidth equal to the chip
rate. The ACLR of the RF_out signal before the DUT and Meas_in signal after the DUT are
measured.
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The ACLR must be higher than the value specified in the following table.
 

 Base Station ACLR

Base Station Adjacent Channel Offset † ACLR Limit

5 MHz 45 dB

10 MHz 50 dB

† Offset below the first or above the last carrier frequency used.

The following figure shows the power of adjacent channels and the ACLR. Test results and
requirements are also shown.

 

 ACLR Measurement Results

The following figure shows the spectrums of the main and the adjacent channels.



Advanced Design System 2011.01 - 3GPP FDD Wireless Test Benches

52

 

 ACLR Spectrums

 

 Occupied Bandwidth Measurement

 The occupied bandwidth (OBW) measurement is defined in 3GPP TS 25.104, section
6.6.1. OBW is a measure of the bandwidth containing 99% of the total integrated power
for transmitted spectrum and is centered on the assigned channel frequency. The occupied
channel bandwidth must be less than 5 MHz based on a chip rate of 3.84 Mcps.

The OBW of RF_out signal before the DUT and the Meas_in signal after the DUT is
measured. Test Model 1 is used. The following figure shows the signal spectrums. The
markers are moved so that the higher and lower percentages of the spectrum add up to
1% of the total power.
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 Occupied Bandwidth Signal Spectrums

The following figure shows the resolution bandwidth and the occupied bandwidth of the
signals.
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 Occupied Bandwidth Measurement Results

 

 CDP Measurement

 The code domain power (CDP) measurement (not defined in 3GPP specifications) is a
measure of power distribution on code domain. CDP is calculated by projecting the power
onto the code domain at a specified spread factor (256). The CDP for every code in the
domain is defined as the ratio of the mean power of the projection onto that code, to the
mean power of the composite reference waveform. The measurement interval is one
timeslot. Test Model 3 is used.

The following figure shows the CDP before and after the DUT.
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 CDP Measurement Results

 

 PCDE Measurement

 This peak code domain error (PCDE) measurement is defined in 3GPP TS 25.104, section
6.8.3. PCDE is calculated by projecting the power of the error vector onto the code domain
at a specified spread factor. The code domain error for every code in the domain is
defined as the ratio of the mean power of the projection onto that code, to the mean
power of the composite reference waveform. This ratio is expressed in dB. The PCDE is
defined as the maximum value for the code domain error for all codes. The measurement
interval is one timeslot. At a spreading factor of 256, the PCDE must not exceed -33dB.

Test Model 3 is used. The following figure shows the PCDE figures before and after the
DUT. Markers mark the peak error and the codes.
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 PCDE Waveforms

The following figure shows the PCDE table. The result is also displayed according to the
specification.

 

 PCDE Measurement Results
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 EVM Measurement

 This error vector magnitude (EVM) measurement is defined in 3GPP TS 25.104, section
6.8.2. EVM is a measure of the difference between the theoretical waveform and a
modified version of the measured waveform. This difference is called the error vector. The
measured waveform is modified by first passing it through a matched root raised-cosine
filter with a bandwidth of 3.84MHz and 0.22 roll-off. The waveform is then further
modified by selecting the frequency, absolute phase, absolute amplitude, and chip clock
timing so as to minimize the error vector. The EVM result is defined as the root of the
mean error vector power to the mean reference signal power expressed as a percent. The
EVM cannot exceed 17.5%.

Test Model 4 is used for this measurement.

The following figure shows the results of the EVM before and after the DUT.

 

 EVM Measurement Results

 

 Test Bench Variables for Data Displays

 Reference variables used to set up this test bench are listed in the following tables.

 Test Bench Constants for Base Station Signal Setup

Constant Value

SamplesPerChip 8

ChipRate 3.84 MHz

ChipsPerSlot 2560

SlotsPerFrame 15
 SourceType Determines Type of Source
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SourceType Type of Source

TestMode1_16DPCHs Test Model 1 with 16 DPCHs (Test Model 1 Active Channels)

TestMode1_32DPCHs Test Model 1 with 32 DPCHs (Test Model 1 Active Channels)

TestMode1_64DPCHs Test Model 1 with 64 DPCHs (Test Model 1 Active Channels)

TestMode2 Test Model 2 (Test Model 2 Active Channels)

TestMode3_16DPCHs Test Model 3 with 16 DPCHs (Test Model 3 Active Channels)

TestMode3_32DPCHs Test Model 2 with 16 DPCHs (Test Model 3 Active Channels)

TestMode4 Test Model 4 (Test Model 4 Active Channels)
 Test Bench Equations Derived from Test Bench Parameters and Exported to Data Display

Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30

RF_R SourceR

TimeStep 1/(ChipRate*SamplesPerChip)
This is the test bench simulation time
step

SlotTime ChipsPerSlot*SamplesPerChip*TimeStep
This is the time duration of each slot

FrameTime SlotTime*SlotsPerFrame

Meas_FMeasurement FMeasurement

Meas_R MeasR
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
The number of time points in one slot can be calculated by SamplesPerChip
times ChipsPerSlot.
ChipRate = 3.84 MHz
SamplesPerChip = 8
ChipsPerSlot = 2560
Resultant WTB_TimeStep = 32.6 nsec; SlotTime = 666.7 µ time points per slot
= 20480

Simulation times and memory requirements.

Measurement Slots Measured Simulation Time (sec) ADS Processes (MB)

RF_Envelope 1 10.5 183

Power 1 5 179

ACLR 1 82 215

Occupied BW 1 11 186

CDP 1 206 179

PCDE 1 450 179

EVM 1 450 179

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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 3GPP FDD RF Power Amplifier Power
Added Efficiency Test
3GPPFDD_RF_PAE_test is the test bench for testing RF Power Amplifiers (PA) with a 3GPP
FDD signal to measure the PA Power Added Efficiency (PAE). The test bench provides a
way for users to connect to an RF circuit device under test (DUT) and determine its PAE
performance over 3GPP FDD signal slot intervals that the user specifies.

3GPP FDD PAE measurements are not specified by the 3GPP Technical Specification.

This 3GPP FDD signal model is compatible with Agilent E4438C ESG Vector Signal
Generator, Option 400 (3GPP W-CDMA Firmware Option for the E4438C ESG Vector Signal
Generator). Details regarding Agilent E4438C ESG are included at the website
http://www.agilent.com/find/esg .

This test bench includes a DSP section, an RF modulator, RF output source resistance, RF
DUT connection, and DSP measurement blocks, as illustrated in the following figure. The
generated test signal is sent to the DUT.

 

 RF PAE Wireless Test Bench Block Diagram

In the 3GPP downlink signal frame structure, one frame has a duration of 10 msec and
consists of 15 slots; each slot contains 2560 chips; each chip is an RF signal symbol.

For details on the 3GPP downlink signal frame structure, see 3GPP FDD Base Station
Transmitter Test (adswtb3g).

For details on the 3GPP uplink signal frame structure, see 3GPP FDD User Equipment
Transmitter Test (adswtb3g).

 

http://www.agilent.com/find/esg
http://www.agilent.com/find/esg
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 Test Bench Basics
A template is provided for this test bench.

 

 3GPP FDD RF Power Amplifier Power Added Efficiency Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose 3GPPFDD_RF_PAE_test, click OK; click2.
left to place the template in the schematic window.

The basics for using the test bench are:

Connect to an RF DUT that is suitable for this test bench.
Configure SweepPlans to define a power sweep. You can add more SweepPlan
controllers as needed.
Set the Circuit_VAR values for: SourcePower_dBm, CE_TimeStep, FSource, and
FMeasurement.
Run the simulation and view Data Display page for your measurement.

Note
The default values work with the DUT provided. Set the values based on your DUT requirements.

 



Advanced Design System 2011.01 - 3GPP FDD Wireless Test Benches

63

 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.

Test bench setup is detailed here.

Replace the DUT (CktPAwithBias is provided with this template) with an RF DUT that1.
is suitable for this test bench.
For information regarding using certain types of DUTs, see RF DUT Limitations for
3GPP FDD Wireless Test Benches (adswtb3g).
Set the Circuit_VAR values that define the power sweep2.

These parameters are used to define a power sweep for the RF signal input to
the DUT so that the PAE measurement can be observed as a function of the DUT
input power.
SourcePower_dBm defines the swept variable used by the ParameterSweep
controller. Configure SweepPlans to define the power sweep. You can add more
SweepPlans as needed.

Set the Required Parameters   3.

Note
Refer to 3GPPFDD_RF_PAE (adswtb3g) for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using Agilent ADS Ptolemy Data
Flow simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings WTB_TimeStep=approx.
130.2 nsec. The value is displayed in the Data Display pages as TimeStep.

WTB_TimeStep = 1/(ChipRate × SamplesPerChip)

where

ChipRate is the non-settable value (3.84 MHz)
SamplesPerChip is the number of waveform sampling points used to
create each chip (RF signal symbol).

Set FSource, SourcePower and FMeasurement.
FSource defines the RF frequency for the signal input to the RF DUT.
SourcePower is defined as the average power during the non-idle time of
the signal. It should be set to the dbmtow(SourcePower_dBm).
FMeasurement defines the RF frequency output from the DUT to be
measured. It is typically set to the FSource value unless the output
frequency of the DUT is other than FSource.

More control of the test bench can be achieved by setting Basic Parameters, Signal4.
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Parameters, and parameters for the measurement. The additional measurement
control enables the user to specific the measurement of the PAE performance over
3GPP FDD signal slot intervals specified by the user. For details refer to Parameter
Settings (adswtb3g).
The RF modulator (shown in the block diagram in RF PAE Wireless Test Bench Block5.
Diagram) uses FSource, SourcePower ( Required Parameters ).
The RF output resistance uses SourceR. The RF output signal source has a 50-ohm
(default) output resistance defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR.
Note that the RF_from_PA point of the test bench provides a resistive load to the RF
DUT set by the MeasR value (50-ohm default) ( Basic Parameters ).
The RF_from_PA signal contains linear and nonlinear signal distortions and time
delays associated with the RF DUT input to output characteristics.
The RF PAE DSP block (shown in the block diagram in RF PAE Wireless Test Bench
Block Diagram) uses other Signal Parameters.
 More control of Circuit Envelope analysis can be achieved by setting Envelope6.
controller parameters. Setting these simulation options is described in Setting Circuit
Envelope Analysis Parameters (adswtbsim). However, Circuit Envelope settings for
Fast Cosim are not intended for use with PAE measurements.
After running a simulation, results will appear in a Data Display window for the7.
measurement. Simulation Measurement Displays (adswtb3g) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 3GPPFDD_RF_PAE 
This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the measurement.

 

Description 3GPP FDD RF Power Amplifier Power Added Efficiency test

 Parameters

Name Description Default Sym Unit Type Range

RequiredParameters       

CE_TimeStep Circuit envelope simulation
time step

1/3.84 MHz/2  sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/3.84e6/SamplesPerChip.
SamplesPerChip is in Signal
Parameters tab.

    

FSource Source carrier frequency 2140 MHz  Hz real (0, ∞)

SourcePower Source power dbmtow(-20.0)  W real [0, ∞)

FMeasurement Measurement carrier
frequency

2140 MHz  Hz real (0, ∞)

Basic
Parameters

      

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

MeasR Measurement resistance 50 Ohm  Ohm real [10,
1.0e6]

Signal
Parameters

      

SpecVersion Secification version: Version
03_00, Version 12_00,
Version 03_02

Version 12_00   enum  

SamplesPerChip Samples per chip 2 S  int [2, 32]

FilterLength RRC filter length (chips) 16   int [1, ∞)

SourceType Source type: Ref_12_2,
Ref_64, Ref_144, Ref_384,
TestModel1_16DPCHs,
TestModel1_32DPCHs,
TestModel1_64DPCHs,
TestModel2,
TestModel3_16DPCHs,
TestModel3_32DPCHs,
TestModel4,
TestModel5_6DPCHs,
TestModel5_14DPCHs,
TestModel5_30DPCHs

TestModel1_16DPCHs   enum  

Measurement
Parameters

      

VDC_Low Low DC bias voltage 2.0  volts real (-∞,
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∞)

VDC_High High DC bias voltage 5.8  volts real (-∞,
∞)

EnableSlotGating Enable slot measurement
gating: NO, YES

YES   int [0, 1)

EnableSlotMarkers Enable slot markers (used
when
EnableSlotGating=YES): NO,
YES

YES   int [0, 1)

InitialStartUpDelay Source signal delay before
first slot starts

0  sec real [0, ∞)

FractionalSlotSegmentIgnored Fractional slot segment
ignored for each slot(used
when
EnableSlotGating=YES)

0   real [0, 1]

FractionalSlotSegmentMeasured Fractional slot segment
measured per slot(used
when
EnableSlotGating=YES)

1   real [0, 1]

NumSlotsMeasured Number of slots measured 2   real [1, ∞]

 Pin Inputs

Pin Name Description Signal Type

4 RF_from_PA Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_to_PA Test bench RF output to RF circuit timed

2 VDC_Low_to_PA Test bench Low VDC voltage to RF circuit timed

3 VDC_High_to_PA Test bench High VDC voltage to RF circuit timed
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 Parameter Settings
More control of the test bench can be achieved by setting parameters on the Basic
Parameters, Signal Parameters, and measurements categories for the activated
measurements. Parameters for each category are described in the following sections.

Note
For required parameter information, see Set the Required Parameters (adswtb3g).

  

 Basic Parameters

SourceR is the RF output source resistance.1.
MeasR defines the load resistance for the RF DUT output RF_from_PA signal into the2.
test bench. This resistance loads the RF DUT output; it is also the reference
resistance for the RF_from_PA signal measurements.

  

 Signal Parameters

SpecVersion is used to specify the 3GPP specification versions (2000-03, 2000-121.
and 2002-03). This is used only when SourceType is not for a TestModel5 type of
source.
SamplesPerChip is used to set the number of samples in a chip. The default value is2.
set to 2 for faster circuit simulation at the cost of lower signal fidelity. It can be set to
a larger value for a simulation frequency bandwidth wider than 2 × 3.84 MHz. If
SamplesPerChip = 8, the simulation RF bandwidth is larger than the signal bandwidth
by a factor of 8 (e.g., simulation RF bandwidth = 8 × 3.84 MHz).
FilterLength is used to set root raised-cosine (RRC) filter length in number of chips.3.
The default value is set to 16 to transmit a 3GPP FDD downlink signal in time and
frequency domains based on the 3GPP standard [4]. It can be set to a smaller value
for faster simulation times; however, this will result in lower signal fidelity.
SourceType is used to specify the type of baseband signal for a 3GPP FDD Downlink4.
source. This source can generate 14 types of baseband signals [5]: Ref_12_2,
Ref_64, Ref_144, Ref_384, TestModel1_16DPCHs, TestModel1_32DPCHs,
TestModel1_64DPCHs, TestModel2, TestModel3_16DPCHs, TestModel3_32DPCHs,
TestModel4, TestModel5_6DPCHs, TestModel5_14DPCHs, and TestModel5_30DPCHs

Ref_12_2, Ref_64, Ref_144, Ref_384 define the reference channel for fully
coded sources.
TestModel5_6DPCHs, TestModel5_14DPCHs, and TestModel5_30DPCHs define
the number of DPCHs used in TestModel5 type sources.
Test Model 1 Active Channels lists the active channels of Test Model 1, which is
used to test spectrum emission mask, ACLR, spurious emissions, transmit
intermodulation, and base station maximum output power.
Test Model 2 Active Channels lists the active channels in Test Model 2, which is
used to test output power dynamics.
Test Model 3 Active Channels lists the active channels of Test Model 3, which is
used to test peak code domain error.
Test Model 4 Active Channels lists the active channels of Test Model 4, which is
used to test EVM.  
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 Test Model 1 Active Channels

Type Number of
Channels

Fraction of
Power (%)

Level
Setting
(dB)

Channelization
Code

Timing Offset
(x256Tchip)

PCCPCH+SCH 1 10 -10 1 0

Primary CPICH 1 10 -10 0 0

PICH 1 1.6 -18 16 120

SCCPCH containing
PCH (SF=256)†

1 1.6 -18 3 0

DPCH (SF=128) 16/32/64 76.8 total see [5] see [5] see [5]

† SCCPCH containing PCH is not included in versions 2000-03 and 2000-12 [5].

 

 Test Model 2 Active Channels

Type Number of
Channels

Fraction of
Power (%)

Level
Setting
(dB)

Channelization
Code

Timing Offset
(x256Tchip )

PCCPCH+SCH 1 10 -10 1 0

Primary CPICH 1 10 -10 0 0

PICH 1 5 -13 16 120

S-CCPCH
containing PCH
(SF=256)

1 5 -13 3 0

DPCH (SF=128) 3 2 x 10,1 x
50

2 x -10, 1
x -3

24, 72, 120 1, 7, 2

† SCCPCH containing PCH is not included in versions 2000-03 and +2000-12+[5]

 

 Test Model 3 Active Channels

Type Number of
Channels

Fraction of
Power (%)
16/32

Level
Settings
(dB) 16/32

Channelization
Code

Timing Offset
(x256Tchip)

PCCPCH+SCH 1 12.6/7.9 -9 / -11 1 0

Primary CPICH 1 12.6/7.9 -9 / -11 0 0

PICH 1 5/1.6 -13 / -18 16 120

SCCPCH
containing PCH
(SF=256) †

1 5/1.6 -13 / -18 3 0

DPCH (SF=256) 16/32 63,7/80,4
total

see
Reference
[5]

see Reference
[5]

see Reference
[5]

† SCCPCH containing PCH is not included in versions 2000-03 and 2000-12 [5]

 

 Test Model 4 Active Channels
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Type Number of
Channels

Fraction of
Power (%)
16/32

Level
Settings
(dB) 16/32

Channelization
Code

Timing Offset
(x256Tchip)

PCCPCH+SCH
when Primary
CPICH is disabled

1 50 to 1.6 -3 to -18 1 0

PCCPCH+SCH
when Primary
CPICH is enabled

1 25 to 0.8 -6 to -21 1 0

Primary CPICH † 1 25 to 0.8 -6 to -21 0 0

† Primary CPICH is optional; it is not included in versions 2000-03 and 2000-12 [5]

  

 Measurement Parameters

VDC_Low specifies the low DC voltage bias voltage provided to the RF power1.
amplifier DUT.
VDC_High specifies the high DC voltage bias voltage provided to the RF power2.
amplifier DUT.
EnableSlotGating and EnableSlotMarkers are the slot gating parameters3.
EnableSlotMarkers is used only when EnableSlotGating=YES.
When EnableSlotGating = NO, there is no slot gating.
When EnableSlotGating = YES and EnableSlotMarkers = NO, the measurement is
made for all gated slot intervals combined.
When EnableSlotGating = YES and EnableSlotMarkers = YES, the measurement is
made for the gated slot interval in each slot and reset at the beginning of each slot.
InitialStartUpDelay specifies the time that the measurement begins at the DUT4.
output and marks the start of the first slot to be measured.
NumSlotsMeasured specifies the number of slots measured.5.
FractionalSlotSegmentIgnored and FractionalSlotSegmentMeasured define the6.
interval in each slot that is measured. The slot measurement interval starts after the
start of a slot defined by the fraction of the slot interval defined by
FractionalSlotSegmentIgnored. After this instant in the slot, the following fraction of
the slot interval is measured as defined by FractionalSlotSegmentMeasured. The slot
interval time is defined within the 3GPPFDD_RF_PAE model.

For information about TimeStep and SlotTime, see Test Bench Variables for Data Displays.
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 Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for each
measurement activated.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for 3GPP FDD Wireless
Test Benches (adswtb3g).

 

 Power Added Efficiency Measurement

The Power Added Efficiency measurement  (not defined in 3GPP specifications) measures
the RF power amplifier (DUT) power added efficiency (in percent). This is the ratio of the
RF output power minus the RF input power, divided by the DC power consumed. This
measurement is made only over the gated slot time interval specified for each slot
measured.

The following figure shows results with EnableSlotGating=YES and
EnableSlotMarkers=YES.

 

 Power Added Efficiency Measurement Results with EnableSlotGating=YES and EnableSlotMarkers=YES

The following figure shows results with EnableSlotGating=YES and EnableSlotMarkers=NO.

 

 Power Added Efficiency Measurement Results with EnableSlotGating=YES and EnableSlotMarkers=NO
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The following figure shows results with EnableSlotGating=NO.

 

 Power Added Efficiency Measurement Results with EnableSlotGating=NO

 

 Test Bench Variables

 Reference variables used to set up this test bench are listed in the following tables.

 Test Bench Constants for Signal Setup
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Constant Value

SamplesPerChip 2

ChipRate 3.84
MHz

ChipsPerSlot 2560
 SourceType Determines Type of Source

SourceType Type of Source

TestMode1_16DPCHs Test Model 1 with 16 DPCHs (Test Model 1 Active Channels
)

TestMode1_32DPCHs Test Model 1 with 32 DPCHs (Test Model 1 Active Channels
)

TestMode1_64DPCHs Test Model 1 with 64 DPCHs (Test Model 1 Active Channels
)

TestMode2 Test Model 2 (Test Model 2 Active Channels)

TestMode3_16DPCHs Test Model 3 with 16 DPCHs (Test Model 3 Active Channels
)

TestMode3_32DPCHs Test Model 2 with 16 DPCHs (Test Model 3 Active Channels
)

TestMode4 Test Model 4 (Test Model 4 Active Channels)
 Test Bench Equations Derived from Test Bench Parameters

Data Display Parameter Equation with Test Bench Parameters

TimeStep 1/(ChipRate*SamplesPerChip)
This is the test bench simulation time
step

SlotTime ChipsPerSlot*SamplesPerChip*TimeStep
This is the time duration of each slot
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 3GPP FDD User Equipment Receiver
Test
3GPPFDD_UE_RX is the test bench for 3GPP FDD user equipment receiver testing. The test
bench provides a way for users to connect to an RF circuit device under test and
determine its performance using pre-defined test bench measurements. This test bench
provides signal measurements for reference sensitivity level, maximum input level,
adjacent channel selectivity, and blocking and intermodulation characteristics.

The signal and the measurements are designed according to 3GPP Technical Specifications
TS 25.101 and TS 34.121. Versions supported are 2000-03, 2000-12, and 2002-03.

This 3GPP FDD signal model is compatible with Agilent E4438C ESG Vector Signal
Generator, Option 400 (3GPP W-CDMA Firmware Option for the E4438C ESG Vector Signal
Generator). Details regarding Agilent E4438C ESG are included at the website
http://www.agilent.com/find/esg .

This test bench includes a TX DSP section, an RF modulator, RF output source resistance,
an RF DUT connection, RF receivers, and DSP measurement blocks as illustrated in the
following figure. The generated test signal is sent to the DUT.

 

 Receiver Wireless Test Bench Block Diagram

 The 3GPPFDD_UE_RX test bench uses the downlink 12.2kbps reference measurement
channel. One 12.2kbps DTCH (dedicated transport channel) and one 2.4kbps DCCH
(dedicated control channel) are multiplexed into one 60kbps DPCH (dedicated physical
data channel). The signal source includes one DPCH, one PCCPCH (primary common
control physical channel), one PSCH (primary synchronization channel), one SSCH
(secondary synchronization channel), one CPICH (common pilot channel), and one PICH
(page indication channel).

In user equipment receiver measurements except maximum input level, channels are set
according to the following table.

 Downlink Physical Channels Transmitted During a Connection

Physical Channel Power

P-CPICH P-CPICH_Ec / DPCH_Ec = 7dB

P-CCPCH P-CCPCH_Ec / DPCH_Ec = 5dB

SCH SCH_Ec / DPCH_Ec = 5dB

PICH PICH_Ec / DPCH_Ec = 2dB

DPCH Test dependent power

SCH power is divided equally between primary and secondary synchronous channels, so

http://www.agilent.com/find/esg
http://www.agilent.com/find/esg
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the P-SCH_Ec/(DPCH_Ec = S-SCH_Ec*DPCH_Ec) = 2dB.

For the maximum input level measurement, the OCNS interference is set to the power
necessary to achieve the required DPCH_Ec/I or of -19dB. The gain of the other channels

remain the same.

All measurements provide BER results for DCCH and DTCH.
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 Test Bench Basics
A template is provided for this test bench.

 

 3GPPFDD User Equipment Receiver Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose 3GPPFDD_UE_RX_test, click OK; click2.
left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click File >
Open > Example > WCDMA3G_RF_Verification_wrk > 3GPPFDD_UE_RX_test .

The basics for using the test bench are:

Connect to an RF DUT that is suitable for this test bench.
CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values
are typically accepted; if not, set values based on your requirements.
Activate/deactivate measurement(s) based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.

Open and use the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose 3GPPFDD_UE_RX_test, click OK; click2.
left to place the template in the schematic window.

The test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For general information regarding using certain types of DUTs, see RF DUT
Limitations for 3GPP FDD Wireless Test Benches (adswtb3g).
 Set the Required Parameters.2.

Note
Refer to 3GPPFDD_UE_RX (adswtb3g) for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using Agilent Ptolemy Data Flow
simulation technology) and the DUT (using Agilent Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
The CE_TimeStep value is exported to the Choosing Analyses window in the
Circuit Envelope Time Step field when the user clicks OK in the Wireless Test
Bench Setup window.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings
WTB_TimeStep=1/(3.84e6 × 8) sec. The value is displayed in the Data Display
pages as TimeStep.

WTB_TimeStep = 1/(ChipRate × SamplesPerChip)

where

ChipRate is the non-settable value (3.84 MHz)
SamplesPerChip is the number of waveform sampling points during
pulse forming.

Set FSource, SourcePower, and FMeasurement.
FSource defines the RF frequency for the signal input to the RF DUT.
SourcePower defines the power level for FSource. SourcePower is defined
as the average power during the non-idle time of the signal.
FMeasurement defines the RF frequency output from the DUT to be
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measured.
MeasType specifies the type of measurement.
Pre-defined measurement settings (according to 3GPP specifications) are
provided for Ior_Power, DPCH_Ec_2_Ior, CW interference, and modulated
interference.

Activate/deactivate ( YES / NO ) test bench measurements (refer to3.
3GPPFDD_UE_RX (adswtb3g)). At least one measurement must be enabled.
More control of the test bench can be achieved by setting Basic Parameters, Signal4.
Parameters, and parameters for each measurement. For details refer to Parameter
Settings (adswtb3g).
The RF modulator (shown in the block diagram in Receiver Wireless Test Bench Block5.
Diagram) uses FSource, SourcePower ( Required Parameters ),
MirrorSourceSpectrum ( Basic Parameters), GainImbalance, PhaseImbalance, I
OriginOffset, Q OriginOffset, and IQ Rotation ( Signal Parameters ).
The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic
Parameters ). The RF output signal source has a 50-ohm (default) output resistance
defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR. The RF signal has additive Gaussian noise power
set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50 Ω default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The TX DSP block (shown in the block diagram in Receiver Wireless Test Bench Block
Diagram) uses other Signal Parameters.
 More control of the Circuit Envelope simulation of the RF DUT is achieved by6.
selecting Options in the Choosing Analysis window. These advanced options include
enabling Automatic Behavioral Modeling (which may speed up the RF DUT simulation
by over 10X), and setting Circuit Envelope parameters. Setting these simulations
options is described in Setting Automatic Behavioral Modeling Parameters and Setting
Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation.
After running a simulation, results will appear in a Data Display window for the7.
measurement. Simulation Measurement Displays (adswtb3g) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 3GPPFDD_UE_RX 
This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 

Description 3GPP FDD UE RX BER
Library WTB
Class TSDF3GPPFDD_UE_RX
Derived From baseWTB_RX

 Parameters

Name Description Default Sym Unit Type Range

RequiredParameters       

CE_TimeStep Circuit envelope simulation
time step

1/3.84 MHz/8  sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/3.84e6/SamplesPerChip.
SamplesPerChip is in Signal
Parameters tab.

    

FSource Source carrier frequency 2140 MHz  Hz real (0, ∞)

FMeasurement Measurement carrier
frequency

2140 MHz  Hz real (0, ∞)

MeasurementInfo Available Measurements
Each measurement has
parameters on its
tab/category below.

    

MeasType Measurement type:
RefLevel, MaxLevel, ACS,
Blocking, Intermod

RefLevel   enum  

BasicParameters       

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor temperature 16.85  Celsius real [-273.15, ∞)

MeasR Measurement resistance 50 Ohm  Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO   enum  

MirrorMeasSpectrum Mirror meas spectrum about
carrier? NO, YES

NO   enum  

DUT_DelayBound DUT delay bound 10.0 usec  sec real [0,
(400.0/3840000)]

TestBenchSeed Random number generator
seed

1234567   int [0, ∞)

SignalParameters       

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)
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PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0   real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0   real (-∞, ∞)

IQ_Rotation IQ rotation 0.0  deg real (-∞, ∞)

SamplesPerChip Samples per chip 8 S  int [2, 32]

RRC_FilterLength RRC filter length (chips) 16   int [1, 1000]

SpecVersion Secification version: Version
03_00, Version 12_00,
Version 03_02

Version 12_00   enum  

RefLevelParameters       

RefLevel_Ior_Power Ior power: Based on
FSource RefLevel, (Band I)
dbmtow(-106.7) RefLevel,
(Band II) dbmtow(-104.7)
RefLevel, (Band III)
dbmtow(-103.7) RefLevel

Based on
FSource
RefLevel

 W real
enum

[0, ∞)

RefLevel_DPCH_Ec_2_Ior DPCH_Ec to Ior value: -
10.3dB RefLevel

-10.3dB
RefLevel

 dB real
enum

(-∞, -10.3]

MaxLevelParameters       

MaxLevel_Ior_Power Ior power: dbmtow(-25)
MaxLevel

dbmtow(-25)
MaxLevel

 W real
enum

(0, ∞)

MaxLevel_DPCH_Ec_2_Ior DPCH_Ec to Ior value: -
19dB MaxLevel

-19dB
MaxLevel

 dB real
enum

(-∞, -10.3]

ACS_Parameters       

ACS_Ior_Power Ior power: dbmtow(-92.7)
ACS

dbmtow(-
92.7) ACS

 W real
enum

(0, ∞)

ACS_DPCH_Ec_2_Ior DPCH_Ec to Ior value: -
10.3dB ACS

-10.3dB ACS  dB real
enum

(-∞, -10.3]

ACS_ModFreqOffset Modulated channel
frequency offset: plus 5MHz
ACS, minus 5MHz ACS

plus 5MHz
ACS

 Hz real
enum

(-∞, ∞)

ACS_ModPower Modulated channel power:
dbmtow(-52) ACS

dbmtow(-52)
ACS

 W real
enum

(0, ∞)

BlockingParameters       

Blocking_Info When
Blocking_ModFreqOffset is
+10 MHz / -10 MHz, the
recommended
SamplesPerChip (in Signal
Parameters Tab) is 16. Also,
set CE_TimeStep equal to or
less than the value
1/3.84e6/SamplesPerChip.

    

Blocking_Ior_Power Ior power: Based on
FSource Blocking, (Band I)
dbmtow(-103.7) Blocking,
(Band II) dbmtow(-101.7)
Blocking, (Band III)
dbmtow(-100.7) Blocking

Based on
FSource
Blocking

 W real
enum

[0, ∞)

Blocking_DPCH_Ec_2_Ior DPCH_Ec to Ior value: -
10.3dB Blocking

-10.3dB
Blocking

 dB real
enum

(-∞, -10.3]

Blocking_ModFreqOffset Modulated channel
frequency offset: plus
10MHz Blocking, minus
10MHz Blocking, plus 15MHz
Blocking, minus 15MHz
Blocking

plus 10MHz
Blocking

 Hz real
enum

(-∞, ∞)
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Blocking_ModPower Modulated channel power:
dbmtow(-56) 10MHz
Blocking, dbmtow(-44)
15MHz Blocking

dbmtow(-56)
10MHz
Blocking

 W real
enum

(0, ∞)

IntermodParameters       

Intermod_Info When
Intermod_ModFreqOffset is
+20 MHz / -20 MHz, the
recommended
SamplesPerChip (in Signal
Parameters Tab) is 32. Also,
set CE_TimeStep equal to or
less than the value
1/3.84e6/SamplesPerChip.

    

Intermod_Ior_Power Ior power: Based on
FSource Intermod, (Band I)
-103.7 dBm Intermod,
(Band II) -101.7 dBm
Intermod, (Band III) -100.7
dBm Intermod

Based on
FSource
Intermod

 W real
enum

[0, ∞)

Intermod_DPCH_Ec_2_Ior DPCH_Ec to Ior value: -
10.3dB Intermod

-10.3dB
Intermod

 dB real
enum

(-∞, -10.3]

Intermod_CW_FreqOffset Continuous wave frequency
offset: plus 10MHz
Intermod_CW, minus 10MHz
Intermod_CW

plus 10MHz
Intermod_CW

 Hz real
enum

(-∞, ∞)

Intermod_CW_Power Continuous wave power:
dbmtow(-46) Intermod_CW

dbmtow(-46)
Intermod_CW

 W real
enum

(0, ∞)

Intermod_ModFreqOffset Modulated channel
frequency offset: plus
20MHz Intermod_Mod,
minus 20MHz Intermod_Mod

plus 20MHz
Intermod_Mod

 Hz real
enum

(-∞, ∞)

Intermod_ModPower Modulated channel power:
dbmtow(-46) Intermod_Mod

dbmtow(-46)
Intermod_Mod

 W real
enum

(0, ∞)

MeasurementParameters       

DisplayPages RX measurement display
pages:
3GPPFDD_UE_RX Tables
3GPPFDD_UE_RX Equations

    

FrameSetsMeasured Sets of 4 frames measured 21   int [2, ∞)

RAKE_PathDelay Path delay for RAKE
(samples)

0   int [0, 2559]

 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed
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 Parameter Settings
More control of the test bench can be achieved by setting parameters on the Basic
Parameters, Signal Parameters, and measurements categories for the activated
measurements. Parameters for each category are described in the following sections.

Note
For required parameter information, see Set the Required Parameters (adswtb3g).

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
MeasR defines the load resistance for the RF DUT output Meas signal into the test3.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the4.
generated RF signal before it is sent to the RF DUT. Depending on the configuration
and number of mixers in an RF transmitter, the signal at the input of the DUT may
need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in5.
RF signal input to the test bench (and output from the RF DUT). Depending on the
configuration and number of mixers in the RF DUT, the signal at its output may be
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and
measurement of the RF DUT output signal requires that its RF envelope is not
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for
measurements on the Meas_in signal in RX text benches and results in measurement
on a signal with no spectrum mirroring.
TestBenchSeed is an integer used to seed the random number generator used with6.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.
DUT_DelayBound is the maximum time delay introduced by the DUT.7.

  

 Signal Parameters

GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are1.
used to add certain impairments to the ideal output RF signal. Impairments are
added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:
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where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, Φ (in degrees) is the phase imbalance.
Next, the signal VRF( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and

Q_OriginOffset are then applied to the rotated signal. Note that the amounts
specified are percentages with respect to the output rms voltage. The output rms
voltage is given by sqrt(2 × SourceR × SourcePower).
SamplesPerChip is used to set the number of samples in a chip.2.
The default value is set to 8 to display settings according to the 3GPP standard. It
can be set to a larger value for a simulation frequency bandwidth wider than 8 ×
3.84 MHz. It can be set to a smaller value for faster simulation; however, this will
result in lower signal fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is
larger than the signal bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8
× 3.84 MHz).
RRC_FilterLength is used to set root raised-cosine (RRC) filter length in number of3.
chips.
The default value is set to 16 to transmit a 3GPP FDD downlink signal in time and
frequency domains based on the 3GPP standard [4]. It can be set to a smaller value
for faster simulation times; however, this will result in lower signal fidelity.
SpecVersion is used to specify the 3GPP specification versions 2000-03, 2000-12 and4.
2002-03.

  

 RefLevel Parameters

RefLevel_Ior_Power is the RF_out power for the reference sensitivity level test1.
(MeasType = RefLevel). If Based on FSource RefLevel is selected,
RefLevel_Ior_Power will be set according to the Operating Band specified by FSource
(see the following table). If FSource does not belong to any Operating Band, the
nearest Operating Band will be used to determine RefLevel_Ior_Power.

 UTRA FDD Frequency Bands and Ior for Reference Sensitivity Test

Operating Band DL Frequencies, UE Receiver (FSource) RefLevel_Ior_Power

I 2110 - 2170 MHz -106.7 dBm

II 1930 - 1990 MHz -104.7 dBm

III 1805 - 1880 MHz -103.7 dBm

RefLevel_DPCH_Ec_2_Ior is the ratio of DPCH chip energy over Ior power for the2.

reference sensitivity level test.
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 MaxLevel Parameters

MaxLevel_Ior_Power is the RF_out power for the maximum input level test.1.
(MeasType = MaxLevel)
MaxLevel_DPCH_Ec_2_Ior is the ratio of DPCH chip energy over Ior power for the2.

maximum input level test.

  

 ACS Parameters

ACS_Ior_Power is the RF_out power for the adjacent channel selectivity test.1.
(MeasType = ACS)
ACS_DPCH_Ec_2_Ior is the ratio of DPCH chip energy over Ior power for the adjacent2.

channel selectivity test.
ACS_ModFreqOffset is the modulated adjacent channel signal frequency offset from3.
the center frequency (FSource) of the assigned channel.
ACS_ModPower is the modulated adjacent channel signal power.4.

  

 Blocking Parameters

Blocking_Ior_Power is the RF_out power for the blocking test (MeasType = Blocking).1.
If Based on FSource Blocking is selected, Blocking_Ior_Power will be set according to
the Operating Band specified by FSource (see the following table). If FSource does
not belong to any Operating Band, the nearest Operating Band will be used to
determine Blocking_Ior_Power.

 UTRA FDD Frequency Bands and Ior for Blocking Test

Operating Band DL Frequencies, UE Receiver (FSource) Blocking_Ior_Power

I 2110 - 2170 MHz -103.7 dBm

II 1930 - 1990 MHz -101.7 dBm

III 1805 - 1880 MHz -100.7 dBm

Blocking_DPCH_Ec_2_Ior is the ratio of DPCH chip energy over Ior power for the2.

blocking test.
Blocking_ModFreqOffset is the unwanted modulated signal frequency offset (other3.
than adjacent channel) from the center frequency (FSource) of the assigned channel.
Blocking_ModPower is the unwanted modulated signal power.4.

  

 Intermod Parameters

Intermod_Ior_Power is the RF_out power for the intermodulation test (MeasType =1.
Intermod). If Based on FSource Intermod is selected, Intermod_Ior_Power will be set
according to the Operating Band specified by FSource (see the following table). If
FSource does not belong to any Operating Band, the nearest Operating Band will be
used to determine Intermod_Ior_Power.
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 UTRA FDD Frequency Bands and Ior for Intermodulation Test

Operating Band DL Frequencies, UE Receiver (FSource) Intermod_Ior_Power

I 2110 - 2170 MHz -103.7 dBm

II 1930 - 1990 MHz -101.7 dBm

III 1805 - 1880 MHz -100.7 dBm

Intermod_DPCH_Ec_2_Ior is the ratio of DPCH chip energy over Ior power for the2.

intermodulation test.
Intermod_CW_FreqOffset is the frequency offset of the continuous wave (un-3.
modulated signal) interference from the center frequency (FSource) of the assigned
channel.
Intermod_CW_Power is the continuous wave interference power.4.
Intermod_ModFreqOffset is the unwanted modulated signal frequency offset from the5.
center frequency (FSource) of the assigned channel.
Intermod_ModPower is the unwanted modulated signal power.6.

  

 Measurement Parameters

DisplayPages provides Data Display page information for this measurement. It cannot1.
be changed by the user.
FrameSetsMeasured is the number of frame sets to be measured. One frame set2.
consists of four radio frames; one radio frame is 10 msec.
RAKE_PathDelay specifies the delay for the signal starting point. If3.
RAKE_PathDelay=0, the delay is automatically searched; if set to a non-zero integer,
the receiver uses this value for the signal starting point.
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 Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for each
measurement. Each Data Display includes tables and equations pages. Simulation results
include the BER of DTCH (dedicated transport channel), DCCH (dedicated control channel)
and DPDCH (dedicated physical data channel), and required parameters to set up the test
benches. Meas BER results are obtained by passing the signals through a DUT.

The DPCH chip energy, denoted by DPCH_Ec, is also displayed, as well as RF source
frequency, DUT output frequency, source output resistance, and DUT output resistance.

All tests require DTCH and DCCH BER performance, which cannot exceed 0.001.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for 3GPP FDD Wireless
Test Benches (adswtb3g).

 

 Reference Sensitivity Level

 The reference sensitivity level (defined in section 7.2 of TS25.104 [4]) is measured when
MeasType is set to RefLevel. Test conditions are:

Parameter Unit Level

DPCH_Ec dBm/3.84MHz -117

Ior dBm/3.84MHz -106.7

The DPCH_Ec_2_Ior is -10.3dB under these conditions. The following figure shows
reference sensitivity level test results.
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 Reference Sensitivity Level Test Results

 

 Maximum Input Level

 The maximum input level (defined in section 7.4 of TS25.101 [4]) is measured when
MeasType is set to MaxLevel. Test conditions are:

Parameter Unit Level

DPCH_Ec/Ior dB -19

Ior dBm/3.84MHz -25

The following figure shows the maximum input level test results.

 

 Maximum Input Level Test Results

 

 Adjacent Channel Selectivity

 The adjacent channel sensitivity (defined in section 7.5 of TS25.101 [4]) is measured
when MeasType is set to ACS. Test conditions are:

Parameter Unit Level

DPCH_Ec dBm/3.84MHz -103

Ior dBm/3.84MHz -92.7

Ioac (modulated) dBm/3.84MHz -52

Fuw (offset) MHz ±5

The I (modulated) signal consists of 16 dedicated data channels. F  is the frequency



Advanced Design System 2011.01 - 3GPP FDD Wireless Test Benches

88

oac uw

offset of the modulated signal. The following figure shows the adjacent channel sensitivity
test results.

 

 Adjacent Channel Sensitivity Test Results

 

 Blocking Characteristics

 The blocking characteristics (defined in section 7.6 of TS25.101 [4]) are tested when
MeasType is set to Blocking. Test conditions are:

Parameter Unit Test Case 1 Test Case 2

DPCH_Ec dBm/3.84MHz -114 -114

Ior dBm/3.84MHz -103.7 -103.7

Iblocking (modulated) dBm/3.84MHz -56 -44

Fuw (offset) MHz +10 or 10 ±15

Iblocking(modulated) consists of common channels and 16 dedicated data channels, and

the frequency offset is Fuw.

The following figure shows the blocking characteristics test results.
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 Blocking Characteristics Test Results

 

 Intermodulation Characteristics

 Intermodulation characteristics (defined in section 7.8 of TS25.101 [4]) are tested when
MeasType is set to Intermod. Test conditions are:

Parameter Unit Level

DPCH_Ec dBm/3.84MHz -114

Ior dBm/3.84MHz -103.7

Iouw1 (CW) dBm -46

Iouw2 (modulated) dBm/3.84MHz -46

Fuw1 (offset) MHz ±10

Fuw2 (offset) MHz ±20

In the RF channel, there are two intermodulation response signals that have a specific
frequency relationship to the requisite signal:

By default, the continuous wave interference has a +10 MHz frequency offset from
the central carrier frequency; its power is -46 dBm.
By default, the modulated interfering signal has a +20 MHz offset from the central
carrier frequency; its power is -46 dBm/3.84 MHz.

The following figure shows the intermodulation characteristics test results.
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 Intermodulation Characteristics Test Results

 

 Test Bench Variables for Data Displays

 
The following table identifies the reference variables used to set up this test bench.

 Test Bench Equations Derived from Test Bench Parameters and Exported to the Data Display
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Data Display
Parameter

Equation with Test Bench Parameters

Spec_Version SpecVersion

RF_FSource FSource

RF_R SourceR

RF_SourceTemp SourceTemp

Ior_Power_dBm 30 + 10 log(Ior_Power), where Ior_Power = RefLevel_Ior_Power, or
MaxLevel_Ior_Power, or ACS_Ior_Power, or Blocking_Ior_Power, or
Intermod_Ior_Power, according to MeasType setting.

DPCH_Ec_2_Ior_dB RefLevel_DPCH_Ec_2_Ior, or MaxLevel_DPCH_Ec_2_Ior, or ACS_DPCH_Ec_2_Ior, or
Blocking_DPCH_Ec_2_Ior, or Intermod_DPCH_Ec_2_Ior, according to MeasType
setting.

ChipRate 3.84MChips/Second

SlotTime 0.667ms

FrameTime 10ms

TimeStep 1/(3.84e6*SamplesPerChip)

Meas_FMeasurement FMeasurement

Meas_R MeasR

FrameNum FrameSetsMeasured * 4

ModFreq FSource + ModFreqOffset, Where ModFreqOffset = ACS_ModFreqOffset, or
Blocking_ModFreqOffset, or Intermod_ModFreqOffset, according to MeasType setting
= ACS, Blocking, or Intermod.

ModePower_dBm 30 + 10 log (ModPower), where ModPower = ACS_ModPower, or Blocking_ModPower
or Intermod_ModPower, according to MeasType setting = ACS, Blocking, or Intermod.

CWFreq FSource + Intermod_CW_FreqOffset, valid when MeasType = Intermod

CWPower_dBm 30 + 10 log(Intermod_CW_Power), valid when MeasType = Intermod
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
The number of time points in one slot can be calculated by SamplesPerChip
times ChipsPerSlot.
ChipRate = 3.84 MHz
SamplesPerChip = 8
ChipsPerSlot = 2560
1 FrameSet = 4 Frames
Resultant WTB_TimeStep = 32.6 nsec; SlotTime = 666.7 µ time points per slot
= 20480

Simulation times and memory requirements.

Measurement FrameSets Measured Simulation Time (sec) ADS Processes (MB)

RefLevel 21 6273 121

MaxLevel 21 6148 100

ACS 21 6819 102

Blocking 21 6935 103

Intermod 21 7655 103

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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 3GPP FDD User Equipment Transmitter
Test
3GPPFDD_UE_TX is the test bench for 3GPP FDD user equipment transmitter testing. The
test bench provides a way for users to connect to an RF circuit device under test and
determine its performance by activating various test bench measurements. This test
bench provides signal measurements for RF envelope, power (including CCDF), occupied
bandwidth, adjacent channel leakage power ratio, adjacent channel leakage power ratio
due to switching transients, code and peak code domain power, and EVM.

The signal and most of the measurements are designed according to the 3GPP Technical
Specification TS 25.101 and TS 34.121. Versions supported are 2000-03, 2000-12, and
2002-03.

This 3GPP FDD signal model is compatible with Agilent E4438C ESG Vector Signal
Generator, Option 400 (3GPP W-CDMA Firmware Option for the E4438C ESG Vector Signal
Generator). Details regarding Agilent E4438C ESG are included at the website
http://www.agilent.com/find/esg .

The DUT output signal can be sent to an Agilent ESG RF signal generator.

This test bench includes a DSP section, an RF modulator, RF output source resistance, RF
DUT connection, RF receivers, and DSP measurement blocks, as illustrated in the following
figure. The generated test signal is sent to the DUT.

 

 Transmitter Wireless Test Bench Block Diagram

In the 3GPP uplink signal frame structure, one frame has a duration of 10 msec and
consists of 15 slots. Each slot corresponds to one power control period and contains 2560
chips.

There are two types of uplink dedicated physical channels - uplink dedicated physical data
channel (uplink DPDCH) and uplink dedicated physical control channel (uplink DPCCH).
These channels are I/Q code multiplexed within each radio frame.

Uplink DPDCH is used to carry the DCH transport channel. There may be zero, one, or
several uplink DPDCHs on each radio link.

Uplink DPCCH is used to carry control information generated at Layer 1. Layer 1 control
information consists of known pilot bits to support channel estimation for coherent
detection, transmit power-control (TPC) commands, feedback information (FBI), and an

http://www.agilent.com/find/esg
http://www.agilent.com/find/esg
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optional transport-format combination indicator (TFCI). The TFCI informs the receiver
about the instantaneous transport format combination of the transport channels mapped
to the simultaneously transmitted uplink DPDCH radio frame. There is only one uplink
DPCCH on each radio link.

The frame structure of the uplink dedicated physical channels is illustrated in the following
figure. The following 4 tables provide more information about each field.

 

 12.2 kbps Uplink Channel Frame Structure

 Uplink 12.2 kbps Reference Measurement Channel, DPDCH Fields

Channel Bit Rate (kbps) Channel Symbol Rate (ksps) SF Bits / Frame Bits / Slot Ndata

60 60 64 600 40 40
 Uplink 12.2 kbps Reference Measurement Channel, DPCCH Fields

Channel Bit Rate
(kbps)

Channel Symbol Rate
(ksps)

SF Bits /
Frame

Bits /
Slot

Npilot NTPC NTFCI NFBI

15 15 256 150 10 6 2 2 0
 Uplink 768 kbps Reference Measurement Channel, Transport Channel Parameters

Parameter DTCH DCCH

Transport Channel Number 1 2

Transport Block Size 3840 100

Transport Block Set Size 7680 100

Transmission Time Interval 10 ms 40 ms

Type of Error Protection Turbo Coding Convolution Coding

Coding Rate 1/3 1/3

Rate Matching attribute 256 256

Size of CRC 16 12
 Uplink 768 kbps Reference Measurement Channel, DPDCH Fields†
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Channel Bit Rate (kbps) Channel Symbol Rate (ksps) SF Bits / Frame Bits / Slot Ndata

960 960 4 9600 640 640

† There are two DPDCHs in uplink 768 kbps RMC.
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 Test Bench Basics
A template is provided for this test bench.

 

 3GPPFDD User Equipment Transmitter Test Bench

To access the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose 3GPPFDD_UE_TX_test, click OK; click2.
left to place the template in the schematic window.

An example design using this template is available; from the ADS Main window click File >
Open > Example > WCDMA3G_RF_Verification_wrk > 3GPPFDD_UE_TX_test .

The basics for using the test bench are:

Connect to an RF DUT that is suitable for this test bench.
CE_TimeStep, FSource, SourcePower, and FMeasurement parameter default values
are typically accepted; if not, set values based on your requirements.
Activate/deactivate measurement(s) based on your requirements.
Run the simulation and view Data Display page(s) for your measurement(s).

For details, refer to Test Bench Details.
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 Test Bench Details
The following sections provide details for setting up a test bench, setting measurement
parameters for more control of the test bench, simulation measurement displays, and
baseline performance.

Open and use the template:

In an Analog/RF schematic window select Insert > Template.1.
In the Insert > Template dialog box, choose 3GPPFDD_UE_TX_test, click OK; click2.
left to place the template in the schematic window.

Test bench setup is detailed here.

Replace the DUT (Amplifier2 is provided with this template) with an RF DUT that is1.
suitable for this test bench.
For general information regarding using certain types of DUTs, see RF DUT
Limitations for 3GPP FDD Wireless Test Benches (adswtb3g).
 Set the Required Parameters2.

Note
Refer to 3GPPFDD_UE_TX (adswtb3g) for a complete list of parameters for this test bench.

Generally, default values can be accepted; otherwise, values can be changed by the
user as needed.

 Set CE_TimeStep.
Cosimulation occurs between the test bench (using Agilent ADS Ptolemy Data
Flow simulation technology) and the DUT (using Circuit Envelope simulation
technology). Each technology requires its own simulation time step with time-
step coordination occurring in the interface between the technologies.
CE_TimeStep defines the Circuit Envelope simulation time step to be used with
this DUT. The CE_TimeStep must be set to a value equal to or a submultiple of
(less than) WTB_TimeStep; otherwise, simulation will stop and an error
message will be displayed.
The CE_TimeStep value is exported to the Choosing Analyses window in the
Circuit Envelope Time Step field when the user clicks OK in the Wireless Test
Bench Setup window.
Note that WTB_TimeStep is not user-settable. Its value is derived from other
test bench parameter values; with default settings
WTB_TimeStep=1/(3.84e6 × 8) sec. The value is displayed in the Data Display
pages as TimeStep.

WTB_TimeStep = 1/(ChipRate × SamplesPerChip)

where

ChipRate is the non-settable value (3.84 MHz)
SamplesPerChip is the number of waveform sampling points during
pulse forming.

Set FSource, SourcePower, and FMeasurement.
FSource defines the RF frequency for the signal input to the RF DUT. The
FSource value is exported to the Choosing Analyses window Fundamental
Tones field when the user clicks OK in the Wireless Test Bench Setup
window.
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SourcePower defines the power level for FSource. SourcePower is defined
as the average power during the non-idle time of the signal.
FMeasurement defines the RF frequency output from the DUT to be
measured.

Activate/deactivate ( YES / NO ) test bench measurements (refer to 3GPPFDD_UE_TX3.
(adswtb3g)). At least one measurement must be enabled.
More control of the test bench can be achieved by setting Basic Parameters, Signal4.
Parameters, and parameters for each activated measurement. For details refer to
Parameter Settings (adswtb3g).
The RF modulator (shown in the block diagram in Transmitter Wireless Test Bench5.
Block Diagram) uses FSource, SourcePower ( Required Parameters ),
MirrorSourceSpectrum ( Basic Parameters), GainImbalance, PhaseImbalance, I
OriginOffset, Q OriginOffset, and IQ Rotation ( Signal Parameters ).
The RF output resistance uses SourceR, SourceTemp, and EnableSourceNoise ( Basic
Parameters ). The RF output signal source has a 50-ohm (default) output resistance
defined by SourceR.
RF output (and input to the RF DUT) is at the frequency specified (FSource), with the
specified source resistance (SourceR) and with power (SourcePower) delivered into a
matched load of resistance SourceR. The RF signal has additive Gaussian noise power
set by resistor temperature (SourceTemp) (when EnableSourceNoise=YES).
Note that the Meas_in point of the test bench provides a resistive load to the RF DUT
set by the MeasR value (50-ohm default) ( Basic Parameters ).
The Meas signal contains linear and nonlinear signal distortions and time delays
associated with the RF DUT input to output characteristics.
The TX DSP block (shown in the block diagram in Transmitter Wireless Test Bench
Block Diagram) uses other Signal Parameters.
 More control of Circuit Envelope analysis can be achieved by setting Envelope6.
controller parameters. These settings include Enable Fast Cosim, which may speed
the RF DUT simulation more than 10×. Setting these simulation options is described
in Setting Fast Cosimulation Parameters and Setting Circuit Envelope Analysis
Parameters in the Wireless Test Bench Simulation documentation.
 To send the RF DUT output signal to an Agilent ESG RF signal generator, set7.
parameters on the Signal to ESG tab.
For details, refer to Signal to ESG Parameters (adswtb3g).
After running a simulation, results will appear in a Data Display window for the8.
measurement. Simulation Measurement Displays (adswtb3g) describes results for
each measurement. For general WTB Data Display details refer to Viewing WTB
Analysis Results (adswtbsim).
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 3GPPFDD_UE_TX 
This section provides parameter information for Required Parameters, Basic Parameters,
Signal Parameters, and parameters for the various measurements.

 

Description 3GPP FDD UE Tx test
Library WTB
Class TSDF3GPPFDD_UE_TX
Derived From baseWTB_TX

 Parameters

Name Description Default Sym Unit Type Range

Required
Parameters

      

CE_TimeStep Circuit envelope simulation
time step

1/3.84 MHz/8  sec real (0, ∞)

WTB_TimeStep Set CE_TimeStep < =
1/3.84e6/SamplesPerChip.

SamplesPerChip is in
Signal Parameters tab.

    

FSource Source carrier frequency 1950 MHz  Hz real (0, ∞)

SourcePower Source power dbmtow(-20.0)  W real [0, ∞)

FMeasurement Measurement carrier
frequency

1950 MHz  Hz real (0, ∞)

MeasurementInfo Available Measurements
Each measurement has
parameters on its
tab/category below.

    

RF_EnvelopeMeasurement Enable RF envelope
measurement? NO, YES

YES   enum  

PowerMeasurement Enable power
measurement? NO, YES

NO   enum  

ACLR_Measurement Enable ACLR
measurement? NO, YES

NO   enum  

ACLR_ST_Measurement Enable ACLR switching
transients measurement?
NO, YES

NO   enum  

OccupiedBW_Measurement Enable occupied bandwidth
measurement? NO, YES

NO   enum  

CDP_Measurement Enable code domain power
measurement? NO, YES

NO   enum  

PCDE_Measurement Enable peak code domain
error measurement? NO,
YES

NO   enum  
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EVM_Measurement Enable EVM measurement?
NO, YES

NO   enum  

Basic
Parameters

      

SourceR Source resistance 50 Ohm  Ohm real (0, ∞)

SourceTemp Source resistor
temperature

-273.15  Celsius real [-273.15, ∞)

EnableSourceNoise Enable source thermal
noise? NO, YES

NO   enum  

MeasR Measurement resistance 50 Ohm  Ohm real [10, 1.0e6]

MirrorSourceSpectrum Mirror source spectrum
about carrier? NO, YES

NO   enum  

MirrorMeasSpectrum Mirror meas spectrum
about carrier? NO, YES

NO   enum  

RF_MirrorFreq Mirror source frequency for
spectrum/envelope
measurement? NO, YES

NO   enum  

MeasMirrorFreq Mirror meas frequency for
spectrum/envelope
measurement? NO, YES

NO   enum  

DUT_DelayBound DUT delay bound 10.0 usec  sec real [0, (400.0/
3840000)]

TestBenchSeed Random number generator
seed

1234567   int [0, ∞)

Signal
Parameters

      

GainImbalance Gain imbalance, Q vs I 0.0  dB real (-∞, ∞)

PhaseImbalance Phase imbalance, Q vs I 0.0  deg real (-∞, ∞)

I_OriginOffset I origin offset (percent) 0.0   real (-∞, ∞)

Q_OriginOffset Q origin offset (percent) 0.0   real (-∞, ∞)

IQ_Rotation IQ rotation 0.0  deg real (-∞, ∞)

SamplesPerChip Samples per chip 8 S  int [2, 32]

RRC_FilterLength RRC filter length (chips) 16   int [2, 128]

SpecVersion Secification version:
Version 03_00, Version
12_00, Version 03_02

Version 12_00   enum  

SourceType Source type: UL_12_2,
UL_768

UL_12_2   enum  

RF_EnvelopeMeasurement
Parameters

      

RF_EnvelopeDisplayPages RF envelope measurement
display pages:
3GPPFDD_UE_TX_Envelope
Figures

    

RF_EnvelopeStart RF envelope measurement
start

0.0  sec real [0, ∞)

RF_EnvelopeStop RF envelope measurement
stop

(2560/3.84) usec  sec real (0, ∞)

RF_EnvelopeSlots RF envelope measurement
slots

1   int [0, 100]

PowerMeasurement
Parameters

      

PowerDisplayPages Power measurement
display pages:
3GPPFDD_UE_TX_Power
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Equations
3GPPFDD_UE_TX_Power
Table
3GPPFDD_UE_TX_Power
Figures

PowerStartSlot Start slot 0   int [0, ∞)

PowerSlotsMeasured Slots measured 1   int [0, ∞)

ACLR_Measurement
Parameters

      

ACLR_DisplayPages ACLR measurement display
pages:
3GPPFDD_UE_TX_ACLR
Equations
3GPPFDD_UE_TX_ACLR
Table
3GPPFDD_UE_TX_ACLR
Figures

    

ACLR_Start Measurement start 0.0  sec real [0, ∞)

ACLR_Stop Measurement stop (2560/3.84) usec  sec real (0, ∞)

ACLR_Slots Measurement slots 0   int [0, 100]

ACLR_SpecMeasResBW Spectrum resolution
bandwidth

0  Hz real [0, ∞)

ACLR_SpecMeasWindow Window type: ACLR_none,
ACLR_Hamming 0.54,
ACLR_Hanning 0.50,
ACLR_Gaussian 0.75,
ACLR_Kaiser 7.865,
ACLR_8510 6.0,
ACLR_Blackman,
ACLR_Blackman-Harris

ACLR_none   enum  

ACLR_ST_Measurement
Parameters

      

ACLR_ST_DisplayPages ACLR ST measurement
display pages:
3GPPFDD_UE_TX_ACLR_ST
Table
3GPPFDD_UE_TX_ACLR_ST
Equations

    

ACLR_ST_Start Measurement start 0.0  sec real [0, ∞)

ACLR_ST_Stop Measurement stop (2560/3.84) usec  sec real (0, ∞)

ACLR_ST_Slots Measurement slots 0   int [0, 100]

OccupiedBW_Measurement
Parameters

      

OBW_DisplayPages Occupied BW measurement
display pages:
3GPPFDD_UE_TX_OBW
Equations
3GPPFDD_UE_TX_OBW
Table
3GPPFDD_UE_TX_OBW
Figures

    

OBW_Start Measurement start 0.0  sec real [0, ∞)

OBW_Stop Measurement stop (2560/3.84) usec  sec real (0, ∞)

OBW_Slots Measurement slots 0   int [0, 100]

OBW_SpecMeasResBW Spectrum resolution
bandwidth

0  Hz real [0, ∞)

OBW_SpecMeasWindow Window type: OBW_none, OBW_none   enum  
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OBW_Hamming 0.54,
OBW_Hanning 0.50,
OBW_Gaussian 0.75,
OBW_Kaiser 7.865,
OBW_8510 6.0,
OBW_Blackman,
OBW_Blackman-Harris

CDP_Measurement
Parameters

      

CDP_DisplayPages CDP measurement display
pages:

    

CDP_StartSlot Start slot 0   int [0, ∞)

PCDE_Measurement
Parameters

      

PCDE_DisplayPages PCDE measurement display
pages:
3GPPFDD_UE_TX_PCDE
Equations
3GPPFDD_UE_TX_PCDE
Table
3GPPFDD_UE_TX_PCDE
Figures

    

PCDE_StartSlot Start slot 0   int [0, ∞)

EVM_Measurement
Parameters

      

EVM_DisplayPages EVM measurement display
pages:
3GPPFDD_UE_TX_EVM
Equations
3GPPFDD_UE_TX_EVM
Table

    

EVM_Start Measurement start 0.0  sec real [0, ∞)

EVM_SlotsMeasured Slots to measure 1   int [0, ∞)

SignalToESG_
Parameters

      

EnableESG Enable signal to ESG? NO,
YES

NO   enum  

ESG_Instrument ESG instrument address [GPIB0::19::INSTR]
[localhost][4790]

  instrument  

ESG_Start Signal start 0.0  sec real [0, ∞)

ESG_Stop Signal stop (2560/3.84) usec  sec real [(ESG_Start+60/
3.84e6/S),
(ESG_Start+32
/3.84/S)]

ESG_Slots Slots to ESG 15   int [0, 1000]

ESG_Power ESG RF ouput power
(dBm)

-20.0   real (-∞, ∞)

ESG_ClkRef Waveform clock reference:
Internal, External

Internal   enum  

ESG_ExtClkRefFreq External clock reference
freq

10 MHz  Hz real (0, ∞)

ESG_IQFilter IQ filter: through,
filter_2100kHz,
filter_40MHz

through   enum  

ESG_SampleClkRate Sequencer sample clock
rate

30.72 MHz  Hz real (0, ∞)

ESG_Filename ESG waveform storage 3GPPFDD_UL   string  
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filename

ESG_AutoScaling Activate auto scaling? NO,
YES

YES   enum  

ESG_ArbOn Select waveform and turn
ArbOn after download? NO,
YES

YES   enum  

ESG_RFPowOn Turn RF ON after
download? NO, YES

YES   enum  

ESG_EventMarkerType Event marker type:
Neither, Event1, Event2,
Both

Event1   enum  

ESG_MarkerLength ESG marker length 10   int [1, 60]

 Pin Inputs

Pin Name Description Signal Type

2 Meas_In Test bench measurement RF input from RF circuit timed

 Pin Outputs

Pin Name Description Signal Type

1 RF_Out Test bench RF output to RF circuit timed

 



Advanced Design System 2011.01 - 3GPP FDD Wireless Test Benches

105

 Parameter Settings
More control of the test bench can be achieved by setting parameters on the Basic
Parameters, Signal Parameters, and measurements categories for the activated
measurements. Parameters for each category are described in the following sections.

Note
For required parameter information, see Set the Required Parameters (adswtb3g).

  

 Basic Parameters

SourceR is the RF output source resistance.1.
SourceTemp is the RF output source resistance temperature (oC) and sets noise2.
density in the RF output signal to (k(SourceTemp+273.15)) Watts/Hz, where k is
Boltzmann's constant.
EnableSourceNoise, when set to NO disables the SourceTemp and effectively sets it3.
to -273.15oC (0 Kelvin). When set to YES, the noise density due to SourceTemp is
enabled.
MeasR defines the load resistance for the RF DUT output Meas signal into the test4.
bench. This resistance loads the RF DUT output; it is also the reference resistance for
Meas signal power measurements.
MirrorSourceSpectrum is used to invert the polarity of the Q envelope of the5.
generated RF signal before it is sent to the RF DUT. Depending on the configuration
and number of mixers in an RF transmitter, the signal at the input of the DUT may
need to be mirrored. If such an RF signal is desired, set this parameter to YES.
MirrorMeasSpectrum is used to invert the polarity of the Q envelope in the Meas_in6.
RF signal input to the test bench (and output from the RF DUT). Depending on the
configuration and number of mixers in the RF DUT, the signal at its output may be
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). Proper demodulation and
measurement of the RF DUT output signal requires that its RF envelope is not
mirrored compared to the signal generated by the signal source (before any mirroring
is done because of the MirrorSourceSpectrum setting). If the Meas_in RF signal is
mirrored, set this parameter to YES. Proper setting of this parameter is required for
measurements on the Meas_in signal in TX test benches (EVM, Constellation, CDP,
PCDE) and results in measurement on a signal with no spectrum mirroring.
TestBenchSeed is an integer used to seed the random number generator used with7.
the test bench. This value is used by all test bench random number generators,
except those RF DUT components that use their own specific seed parameter.
TestBenchSeed initializes the random number generation. The same seed value
produces the same random results, thereby giving you predictable simulation results.
To generate repeatable random output from simulation to simulation, use any
positive seed value. If you want the output to be truly random, enter the seed value
of 0.
RF_MirrorFreq is used to invert the polarity of the Q envelope in the RF_out RF signal8.
for RF envelope, ppectrum, ACLR, and occupied bandwidth measurements.
RF_MirrorFreq is typically set by the user to NO when MirrorSourceSpectrum = NO;
RF_MirrorFreq is typically set by the user to YES when MirrorSourceSpectrum = YES.
Both settings result in viewing the RF_out signal with no spectrum mirroring. Other
settings by the user result in RF_out signal for RF_Envelope and Spectrum
measurements with spectrum mirroring.
MeasMirrorFreq is used to invert the polarity of the Q envelope in the Meas_in RF9.
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signal for the RF envelope, spectrum, ACLR, and occupied bandwidth measurements.
MeasMirrorFreq is typically set to NO by the user when the combination of the
MirrorSourceSpectrum value and any signal mirroring in the users RF DUT results in
no spectrum mirroring in the Meas_in signal. MeasMirrorFreq is typically set to YES
by the user when the combination of the MirrorSourceSpectrum and RF DUT results
in spectrum mirroring in the Meas_in signal.
Other settings result in Meas_in signal for RF_Envelope and Spectrum measurements
with spectrum mirroring. The MirrorMeasSpectrum parameter setting has no impact
on the setting or use of the MeasMirrorFreq parameter.
DUT_DelayBound is used to transfer the DUT delay for measurement synchronization.10.
For measurements of RF_out before the DUT, RF delay bound is calculated by adding
the delays caused by RRC filters in modulation and measurements. For
measurements of the RF DUT output (Meas_in), the Meas delay bound is calculated
by adding the DUT_DelayBound to the RF delay bound.

  

 Signal Parameters

GainImbalance, PhaseImbalance, I_OriginOffset, Q_OriginOffset, and IQ_Rotation are1.
used to add certain impairments to the ideal output RF signal. Impairments are
added in the order described here.
The unimpaired RF I and Q envelope voltages have gain and phase imbalance
applied. The RF is given by:

where A is a scaling factor that depends on the SourcePower and SourceR
parameters specified by the user, VI( t ) is the in-phase RF envelope, VQ( t ) is the

quadrature phase RF envelope, g is the gain imbalance

and, Φ (in degrees) is the phase imbalance.
Next, the signal VRF( t ) is rotated by IQ_Rotation degrees. The I_OriginOffset and

Q_OriginOffset are then applied to the rotated signal. Note that the amounts
specified are percentages with respect to the output rms voltage. The output rms
voltage is given by sqrt(2 × SourceR × SourcePower).
SamplesPerChip is used to set the number of samples in a chip. The default value is2.
set to 8 to display settings according to the 3GPP standard. It can be set to a larger
value for a simulation frequency bandwidth wider than 8 × 3.84 MHz. It can be set to
a smaller value for faster simulation times; however, this will result in lower signal
fidelity. If SamplesPerChip = 8, the simulation RF bandwidth is larger than the signal
bandwidth by a factor of 8 (e.g., simulation RF bandwidth = 8 × 3.84 MHz).
RRC_FilterLength is used to set root raised-cosine filter length in chips. The default3.
value is set to 16 to transmit a 3GPP FDD uplink signal in time and frequency
domains based on the 3GPP standard [4]. It can be set to a smaller value for faster
simulation times; however, this will result in lower signal fidelity. Better Adjacent
Channel Leakage Ratio (ACLR) can be obtained using a longer filter length.
Increasing RRC_FilterLength to 24 or 32 should result in a better ACLR. This may also
correlate better to ACLR measurements when using instruments from Agilent
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Technologies.
SpecVersion is used to specify the 3GPP specification versions 2000-03, 2000-12 or4.
2002-03.
SourceType is used to specify the type of baseband signal. Reference measurement5.
channels 12.2 and 768 kbps as defined in [4] and [5] are available. Basic parameters
of these channels are listed in the following tables.

 Uplink 12.2 kbps Reference Measurement Channel, Physical Parameters

Parameter Unit Level

Information bit rate kbps 12.2

DPDCH kbps 60

DPCCH kbps 15

DPCCH Slot Format  0

DPCCH/DPDCH power ratio dB -5.46

TFCI  On

Repetition % 23
 Uplink 12.2 kbps Reference Measurement Channel, Transport Channel Parameters

Parameter DTCH DCCH

Transport Channel Number 1 2

Transport Block Size 244 100

Transport Block Set Size 244 100

Transmission Time
Interval

20 ms 40 ms

Type of Error Protection Convolution
Coding

Convolution
Coding

Coding Rate 1/3 1/3

Rate Matching attribute 256 256

Size of CRC 16 12
 Uplink 768 kbps Reference Measurement Channel, Physical Parameters

Parameter Unit Level

Information bit rate kbps 2*384

DPDCH1 kbps 960

DPDCH2 kbps 960

DPCCH kbps 15

DPCCH Slot Format  0

DPCCH/DPDCH power ratio dB -
11.48

TFCI  On

Puncturing % 18
 Uplink 768 kbps Reference Measurement Channel, Transport Channel Parameters
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Parameter DTCH DCCH

Transport Channel Number 1 2

Transport Block Size 3840 100

Transport Block Set Size 7680 100

Transmission Time
Interval

10 ms 40 ms

Type of Error Protection Turbo Coding Convolution
Coding

Coding Rate 1/3 1/3

Rate Matching attribute 256 256

Size of CRC 16 12

  

 RF Envelope Parameters

This measurement is not affected by the MirrorMeasSpectrum parameter. To apply
spectrum mirroring to the measured RF_out signal, set RF_MirrorFreq = YES. To apply
spectrum mirroring to the measured Meas_in signal, set MeasMirrorFreq = YES.

RF_EnvelopeDisplayPages provides Data Display page information for this1.
measurement. It cannot be changed by the user.
RF_EnvelopeStart sets the start time for collecting input data.2.
RF_EnvelopeStop sets the stop time for collecting input data when RF_EnvelopeSlots3.
= 0.
RF_EnvelopeSlots (when > 0) sets the number of slots over which data will be4.
collected.

Depending on the values of RF_EnvelopeStart, RF_EnvelopeStop, and RF_EnvelopeSlots,
the stop time may be adjusted.

For RF envelope measurement for both the RF_out and Meas_in signals:

Let:
Start = TimeStep * (int(RF_EnvelopeStart/TimeStep) + 0.5)
Stop = TimeStep * (int(RF_EnvelopeStop/TimeStep) + 0.5)

This means Start and Stop are forced to be an integer number of time-step intervals.

RF_EnvelopeSlots Resultant Stop Time

0 Stop

> 0 Start + RF_EnvelopeSlots x SlotTime

For the RF envelope of Meas_in to contain at least one complete slot, the Stop value
should be set to a minimum of SlotTime + (RF DUT time delay).

For information about TimeStep and SlotTime, see Test Bench Variables for Data Displays.

  

 Power Measurement Parameters

PowerDisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
PowerStartSlot sets the number of slots which should be ignored.2.
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PowerSlotsMeasured sets the number of slots over which data will be collected.3.

The measurement start time is PowerStartSlot × SlotTime. The measurement stop time is
(PowerStartSlot+PowerSlotsMeasured) × SlotTime. SlotTime is defined in Test Bench
Variables for Data Displays.

  

 ACLR Measurement Parameters

The ACLR measurement is implemented by the spectrum measurement, which measures
the RF signal spectrum in different frequency offsets. The ACLR can be calculated by
analyzing the spectrum measurement in the data display file.

In the following, TimeStep denotes the simulation time step, and FMeasurement denotes
the measured RF signal characterization frequency.

The measurement outputs the complex amplitude voltage values at the frequencies1.
of the spectral tones. It does not output power at frequencies of the spectral tones.
However, one can calculate and display the power spectrum as well as the magnitude
and phase spectrum by using the dBm, mag, and phase functions of the data display
window.
Note that the dBm function assumes a 50-ohm reference resistance; if a different
measurement was used in the test bench, its value can be specified as a second
argument to the dBm function, for example, dBm(SpecMeas, Meas_RefR) where
SpecMeas is the instance name of the spectrum measurement and Meas_RefR is the
resistive load used.
By default, the displayed spectrum extends from FMeasurement - 1/(2TimeStep) Hz
to FMeasurement + 1/(2TimeStep) Hz. When FMeasurement < 1/(2TimeStep), the
default spectrum extends to negative frequencies. The spectral content at these
negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. This way, the negative frequency tones are displayed
on the positive frequency axis as would happen in an RF spectrum analyzer
measurement instrument. This process may introduce an error in the displayed
frequency for the mirrored tones. The absolute error introduced is less than
(spectrum frequency step) / 2 (see the following table for the definition of spectrum
frequency step).
The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple slots and average the results to achieve
video averaging (see note 6).
ACLR_DisplayPages provides Data Display page information for this measurement. It2.
cannot be changed by the user.
ACLR_Start sets the start time for collecting input data.3.
ACLR_Stop sets the stop time for collecting input data when ACLR_Slots = 0 and4.
ACLR_SpecMeasResBW = 0.
ACLR_Slots (when > 0) sets the number of slots over which data will be collected.5.
ACLR_SpecMeasResBW (when > 0) sets the resolution bandwidth of the spectrum6.
measurement.
Depending on the values of ACLR_Stop, ACLR_Slots, and ACLR_SpecMeasResBW, the
stop time may be adjusted and/or spectrum video averaging may occur. The different
cases are explained in the following table.
Referring to the following table let:

Start = TimeStep × int((ACLR_Start/TimeStep) + 0.5)
Stop = TimeStep × int((ACLR_Stop/TimeStep) + 0.5)
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(This means Start and Stop are forced to be an integer number of time step
intervals.)
X be the Normalized Equivalent Noise BW of the window used

Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular
filter. It is the equivalent width of a rectangular filter that passes the same amount of
white noise as the window. The normalized ENBW is the ENBW multiplied by the time
duration of the signal being windowed. See Window Options and Normalized
Equivalent Noise Bandwidth for the normalized ENBW for the different window
options available.
The Start and Stop times are used for both the RF_out and Meas_in signal spectrum
analyses. The Meas_in signal is delayed in time from the RF_out signal by the value
of the RF DUT time delay. Thus for RF DUT time delay > 0, the RF_out and Meas_in
signal are inherently different and some spectrum display difference in the two is
expected.
TimeStep and SlotTime are defined in Test Bench Variables for Data Displays.

 Effect of Different Values for ACLR_Stop, ACLR_Slots, and ACLR_SpecMeasResBW
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Case
1

ACLR_Slots = 0
ACLR_SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case
2

ACLR_Slots > 0
ACLR_SpecMeasResBW = 0
Resultant stop time = Start + ACLR_Slots x SlotTime

Notes: For ACLR_Slots > 0 and ACLR_SpecMeasResBW = 0
Video averaging occurs over all slot time intervals

Resultant resolution BW = X/SlotTime
Resultant spectrum frequency step = 1/SlotTime
Video averaging status = Yes, when ACLR_Slots > 1

Case
3

ACLR_Slots = 0
ACLR_SpecMeasResBW > 0
Resultant stop time = Start + N*SlotTimeInterval
where
N = int((Stop -Start)/SlotTimeInterval) + 1

For ACLR_Slots = 0 and ACLR_SpecMeasResBW > 0
Define SlotTimeInterval = TimeStep * int((X/(ACLR_SpecMeasResBW*TimeStep)) +
0.5)
This means SlotTimeInterval is forced to a value that is an integer number of time
step intervals.
(Stop-Start) time is forced to be an integer number (N) of SlotTimeInterval
N has a minimum value of 1
Video averaging occurs over all SlotTimeInterval
The resolution bandwidth achieved is ResBW = X / SlotTimeInterval, which is very
close to ACLR_SpecMeasResBW but may not be exactly the same if
X/(ACLR_SpecMeasResBW*TimeStep) is not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case
4

ACLR_Slots > 0
ACLR_SpecMeasResBW > 0
Resultant stop time = Start + M*SlotTimeInterval
where
M = int((ACLR_Slots x SlotTime)/SlotTimeInterval) + 1

For ACLR_Slots > 0 and ACLR_SpecMeasResBW > 0
Define SlotTimeInterval = TimeStep * int((X/(ACLR_SpecMeasResBW*TimeStep)) +
0.5)
This means SlotTimeInterval is forced to a value that is an integer number of time
step intervals.
(Stop-Start) time is forced to be an integer number (M) of the SlotTimeInterval
M has a minimum value of 1
Video averaging occurs over all SlotTimeIntervals
The resolution bandwidth achieved is ResBW = X / SlotTimeInterval, which is very
close to ACLR_SpecMeasResBW but may not be exactly the same if
X/(ACLR_SpecMeasResBW*TimeStep) is not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1

ACLR_SpecMeasWindow specifies the window that will be applied to each slot before7.
its spectrum is calculated. Different windows have different properties, affect the
resolution bandwidth achieved, and affect spectral shape. Windowing is often
necessary in transform-based (chirp-Z, FFT) spectrum estimation in order to reduce
spectral distortion due to discontinuous or non-harmonic signal over the
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measurement time interval. Without windowing, the estimated spectrum may suffer
from spectral leakage that can cause misleading measurements or masking of weak
signal spectral detail by spurious artifacts.
The windowing of a signal in time has the effect of changing its power. The spectrum
measurement compensates for this and the spectrum is normalized so that the power
contained in it is the same as the power of the input signal.
Window Type Definitions:

none

where N is the window size
Hamming 0.54

where N is the window size
Hanning 0.50

where N is the window size
Gaussian 0.75

where N is the window size
Kaiser 7.865

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
8510 6.0 (Kaiser 6.0)

where N is the window size,  α = N / 2, and I0(.) is the 0th order modified

Bessel function of the first kind
Blackman
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where N is the window size
Blackman-Harris

where N is the window size.

 Window Options and Normalized Equivalent Noise Bandwidth

Window and Default Constant NENBW

none 1

Hamming 0.54 1.363

Hanning 0.50 1.5

Gaussian 0.75 1.883

Kaiser 7.865 1.653

8510 6.0 1.467

Blackman 1.727

Blackman-Harris 2.021

  

 ACLR due to Switching Transient Measurement Parameters

ACLR_ST_DisplayPages provides Data Display page information for this1.
measurement. It cannot be changed by the user.
ACLR_ST_Start sets the start time for collecting input data.2.
ACLR_ST_Stop sets the stop time for collecting input data when ACLR_ST_Slots = 0.3.
ACLR_ST_Slots (when > 0) sets the number of slots over which data will be4.
collected.

Depending on the values of ACLR_ST_Start, ACLR_ST_Stop, and ACLR_ST_Slots, the stop
time may be adjusted.

For ACLR ST measurement for both the RF_out and Meas_in signals:

Let:
Start = TimeStep × (int(ACLR_ST_Start/TimeStep) + 0.5)
Stop = TimeStep × (int(ACLR_ST_Stop/TimeStep) + 0.5)
This means Start and Stop are forced to be an integer number of time-step
intervals.

ACLR_ST_Slots Resultant stop time

0 Stop

> 0 Start + ACLR_ST_Slots x SlotTime

For the ACLR ST of Meas_in to contain at least one complete slot, the Stop value should
be set to a minimum of SlotTime + (RF DUT time delay).
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For information about TimeStep and SlotTime, see Test Bench Variables for Data Displays.

  

 OBW Measurement Parameters

The occupied bandwidth measurement is implemented by the spectrum measurement
which measures the spectrum of the input signal. The occupied bandwidth is calculated by
analyzing the spectrum measured in data display files.

In the following notes, TimeStep denotes the simulation time step, and FMeasurement
denotes the measured RF signal characterization frequency.

OBW_DisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
The measurement outputs the complex amplitude voltage values at spectral tone2.
frequencies.
Spectral tone frequency power is not output; however, power, magnitude, and phase
spectrums can be calculated and displayed by using the dBm, mag, and phase
functions of the data display window. Note that the dBm function assumes a 50-ohm
measurement reference resistance; if a different reference resistance measurement
is used in the test bench, its value can be specified as a second argument to the dBm
function; for example, dBm(SpecMeas, Meas_RefR) where SpecMeas is the instance
name of the spectrum measurement and Meas_RefR is the resistive load used.
By default, the displayed spectrum extends from FMeasurement - 1/(2TimeStep) Hz
to FMeasurement + 1/(2TimeStep) Hz. When FMeasurement < 1/(2TimeStep), the
default spectrum extends to negative frequencies. The spectral content at these
negative frequencies is conjugated, mirrored, and added to the spectral content of
the closest positive frequency. This way, the negative frequency tones are displayed
on the positive frequency axis as would happen in an RF spectrum analyzer
measurement instrument. This process may introduce an error in the displayed
frequency for the mirrored tones. The absolute error introduced is less than
(spectrum frequency step) / 2 (see the following table for the definition of spectrum
frequency step).
The basis of the algorithm used by the spectrum measurement is the chirp-Z
transform. The algorithm can use multiple slots and average the results to achieve
video averaging (see note 8).
OBW_Start sets the start time for collecting input data.3.
OBW_Stop sets the stop time for collecting input data when OBW_Slots = 0 and4.
OBW_SpecMeasResBW = 0.
OBW_Slots (when > 0) sets the number of slots over which data will be collected.5.
OBW_SpecMeasResBW (when > 0)sets the resolution bandwidth of the spectrum6.
measurement.
Depending on the values of OBW_Stop, OBW_Slots, and OBW_SpecMeasResBW, the
stop time may be adjusted and/or spectrum video averaging may occur. The different
cases are explained in the following table.
Let:

Start = TimeStep × int((OBW_Start/TimeStep) + 0.5)
Stop = TimeStep × int((OBW_Stop/TimeStep) + 0.5)
(This means Start and Stop are forced to be an integer number of time step
intervals.)
X be the Normalized Equivalent Noise BW of the window used

Equivalent noise bandwidth (ENBW) compares the window to an ideal, rectangular
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filter. It is the equivalent width of a rectangular filter that passes the same amount of
white noise as the window. The normalized ENBW is the ENBW multiplied by the time
duration of the signal being windowed. See Window Options and NENBW for the
normalized ENBW for the different window options available.

 Effect of Different Values for OBW_Stop, OBW_Slots, and OBW_SpecMeasResBW
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Case
1

OBW_Slots = 0
OBW_SpecMeasResBW = 0
Resultant stop time = Stop
Resultant resolution BW = X/(Stop - Start)
Resultant spectrum frequency step = 1/(Stop-Start)
Video averaging status = None

Case
2

OBW_Slots > 0
OBW_SpecMeasResBW = 0
Resultant stop time = Start + OBW_Slots x SlotTime

For OBW_Slots > 0 and OBW_SpecMeasResBW = 0
Video averaging occurs over all slot time intervals

Resultant resolution BW = X/SlotTime
Resultant spectrum frequency step = 1/SlotTime
Video averaging status = Yes, when OBW_Slots > 1

Case
3

OBW_Slots = 0
OBW_SpecMeasResBW > 0
Resultant stop time = Start + N*SlotTimeInterval
where
N = int((Stop -Start)/SlotTimeInterval) + 1

For OBW_Slots = 0 and OBW_SpecMeasResBW > 0
Define SlotTimeInterval = TimeStep * int((X/(OBW_SpecMeasResBW*TimeStep)) +
0.5)
This means SlotTimeInterval is forced to a value that is an integer number of time
step intervals.
(Stop-Start) time is forced to be an integer number (N) of SlotTimeInterval
N has a minimum value of 1
Video averaging occurs over all SlotTimeInterval
The resolution bandwidth achieved is ResBW = X / SlotTimeInterval, which is very
close to OBW_SpecMeasResBW but may not be exactly the same if
X/(OBW_SpecMeasResBW*TimeStep) is not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes when N > 1

Case
4

OBW_Slots > 0
OBW_SpecMeasResBW > 0
Resultant stop time = Start + M*SlotTimeInterval
where
M = int((OBW_Slots x SlotTime)/SlotTimeInterval) + 1

For OBW_Slots > 0 and OBW_SpecMeasResBW > 0
Define SlotTimeInterval = TimeStep * int((X/(OBW_SpecMeasResBW*TimeStep)) +
0.5)
This means SlotTimeInterval is forced to a value that is an integer number of time
step intervals.
(Stop-Start) time is forced to be an integer number (M) of the SlotTimeInterval
M has a minimum value of 1
Video averaging occurs over all SlotTimeInterval
The resolution bandwidth achieved is ResBW = X / SlotTimeInterval, which is very
close to OBW_SpecMeasResBW but may not be exactly the same if
X/(OBW_SpecMeasResBW*TimeStep) is not an exact integer.

Resultant resolution BW = ResBW
Resultant spectrum frequency step = ResBW
Video averaging status = Yes, when M > 1

The Start and Stop times are used for both the RF_out and Meas_in signal spectrum
analyses. The Meas_in signal is delayed in time from the RF_out signal by the value
of the RF DUT time delay. Thus for RF DUT time delay greater than zero, the RF_out
and Meas_in signal are inherently different and some spectrum display difference in
the two is expected.
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TimeStep and Slot_Time are defined in Test Bench Variables for Data Displays
OBW_SpecMeasWindow specifies the type of window. Different windows have7.
different properties, affect the resolution bandwidth achieved, and affect spectral
shape. The OBW_SpecMeasWindow is used to define the window that will be applied
to each slot before its spectrum is calculated. Windowing is often necessary in
transform-based (chirp-Z, FFT) spectrum estimation in order to reduce spectral
distortion due to discontinuous or non-harmonic signal over the measurement time
interval. Without windowing, the estimated spectrum may suffer from spectral
leakage that can cause misleading measurements or masking of weak signal spectral
detail by spurious artifacts.
Window Type Definitions:

Hanning

where W = WindowConstant
Hamming

where W = WindowConstant
Blackman

Kaiser (Kaiser-Bessel)

Here α = NPoints / 2, β is the shape parameter (set by WindowConstant ), and I0
(.) is the 0 th order modified Bessel function of the first kind.
Gaussian (Weierstrass)

where α = WindowConstant.

 Window Options and NENBW
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Window and Default Constant Normalized Equivalent Noise BW (X)

None 1

Hamming 0.54 Not defined (1 is used)

Hanning 0.50 1.5

Gaussian 0.75 2.215

Kaiser 7.865 Not defined (1 is used)

8510 6.0 Not defined (1 is used)

Blackman Not defined (1 is used)

Blackman-Harris Not defined (1 is used)

The windowing of a signal in time has the effect of changing its power. The
spectrum measurement compensates for this and the spectrum is normalized so
that the power contained in it is the same as the power of the input signal.

  

 CDP Measurement Parameters

CDP_DisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
CDP_StartSlot sets the starting slot from which slot data will be collected. The2.
CDP_StartSlot is used for both the RF_out and Meas_in CDP analyses.

The measurement interval is one timeslot. The length of time that data will be collected is
SlotTime. See Test Bench Equations Derived from Test Bench Parameters and Exported to
the Data Display.

  

 PCDE Measurement Parameters

PCDE_DisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
PCDE_StartSlot sets the starting slot from which slot data will be collected.2.
PCDE_StartSlot is used for both RF_out and Meas_in PCDE analyses.

The measurement interval is one timeslot. The length of time that data will be collected is
SlotTime. See Test Bench Equations Derived from Test Bench Parameters and Exported to
the Data Display.

  

 EVM Parameters

EVM_DisplayPages provides Data Display page information for this measurement. It1.
cannot be changed by the user.
EVM_Start specifies starting time instant for the measurement. EVM_Start time is2.
used for RF_out and Meas_in EVM analyses. The Meas_in signal is delayed in time
from the RF_out signal by the RF DUT time delay value. Thus for RF DUT time delay
>0, RF_out and Meas_in signals are inherently different and some EVM difference in
the two is expected even if the RF DUT does not introduce any distortion other than
time delay.
EVM_SlotsMeasured specifies the measurement interval. The time length of data to3.
be collected is EVM_SlotMeasured × SlotTime. See Test Bench Equations Derived
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from Test Bench Parameters and Exported to the Data Display.

  

 Signal to ESG Parameters

The EVM measurement collects data from the Meas_in signal and downloads it to an
Agilent E4438C Vector Signal Generator. This measurement uses Connection Manager
architecture to communicate with the instrument; parameters specify how data is
interpreted.

Prerequisites for using the Signal to ESG option are:

ESG Vector Signal Generator E4438C; for information, visit the web site
http://www.agilent.com/find/esg .
PC workstation running an instance of the connection manager server.
Supported method of connecting the instrument to your computer through the
Connection Manager architecture; for information, see Connection Manager.

 

 Parameter Information

EnableESG specifies if the signal is downloaded to the ESG instrument. If set to NO,1.
no attempt will be made to communicate with the instrument.
ESG_Instrument specifies a triplet that identifies the VSA resource of the instrument2.
to be used in the simulation, the connection manager server hostname (defaults to
localhost ), and the port at which the connection manager server listens for incoming
requests (defaults to 4790). To ensure that this field is populated correctly, click
Select Instrument, enter the server hostname and port, click OK to see the Remote
Instrument Explorer dialog, select a VSA resource identifier, and click OK. For details
about selecting instruments, see Instrument Discovery in the Wireless Test Bench
Simulation documentation.
ESG_Start and ESG_Stop (when ESG_Slots=0) specify when to start and stop data3.
collection. The number of samples collected, ESG_Stop - ESG_Start + 1, must be in
the range 60 samples to 64 Msamples, where 1 Msample = 1,048,576 samples. The
ESG requires an even number of samples; the last sample will be discarded if
ESG_Stop - ESG_Start + 1 is odd.
ESG_Slots sets the number of slots over which data will be collected. When4.
ESG_Slots > 0, ESG_Stop is forced to ESG_Start + ESG_Slots x SlotTime (where
SlotTime is 5 msec).
ESG_ClkRef specifies an internal or external reference for the ESG clock generator. If5.
set to External, the ESG_ExtClkRefFreq parameter sets the frequency of this clock.
ESG_IQFilter specifies the cutoff frequency for the reconstruction filter that lies6.
between the DAC output and the Dual Arbitrary Waveform Generator output inside
the ESG.
ESG_SampleClkRate sets the sample clock rate for the DAC output.7.
ESG_FileName sets the name of the waveform inside the ESG that will hold the8.
downloaded data.
The ESG driver expects data in the range {-1, 1}. ESG_AutoScaling specifies whether9.
to scale inputs to fit this range. If set to YES, inputs are scaled to the range {-1, 1};
if set to NO, raw simulation data is downloaded to the ESG without any scaling, but
data outside the range {-1, 1} is clipped to -1 or 1. If set to YES, scaling is also
applied to data written to the local file (ESG_FileName setting).
If ESG_ArbOn is set to YES, the ESG will start generating the signal immediately after10.

http://www.agilent.com/find/esg
http://www.agilent.com/find/esg
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simulation data is downloaded; if set to NO, waveform generation must be turned on
at the ESG front panel.
If ESG_RFPowOn is set to YES, the ESG will turn RF power on immediately after11.
simulation data is downloaded. If ESG_RFPowOn is set to NO (default), RF power
must be turned on at the ESG front panel.
ESG_EventMarkerType specifies which ESG Event markers are enabled: Event1,12.
Event2, Both, or Neither. Event markers are used for synchronizing other instruments
to the ESG. When one or both EventMarkers are enabled, Event1 and/or Event2 is set
beginning from the first sample of the downloaded Arb waveform over the range of
points specified by the ESG_MarkerLength parameter. This is equivalent to setting
the corresponding event from the front panel of the ESG.
ESG_MarkerLength specifies the range of points over which the markers must be set13.
starting from the first point of the waveform. Depending on the setting of
ESG_EventMarkerType, the length of trigger Event1 or Event2 (or both) is set to a
multiple of the pulsewidth that, in turn, is determined by the sample clock rate of the
DAC output.
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 Simulation Measurement Displays
After running the simulation, results are displayed in the Data Display pages for each
measurement activated.

Note
Measurement results from a wireless test bench have associated names that can be used in Data Display
Expressions. For more information, refer to Measurement Results for Expressions for 3GPP FDD Wireless
Test Benches (adswtb3g).

 

 RF Envelope Measurement

The RF Envelope measurement (not defined in 3GPP specifications) shows the time
envelope of the 3GPP FDD RF signal. Two kinds of signals are tested: the RF signal which
does not go through the DUT, and the Meas signal which does go through the DUT and
may contain a few microseconds of delay, some noise, and nonlinearity.

 Measurement results are shown in the following figure. Tables at the top of the data
display page show some basic measurement parameters. The waveforms show the
envelopes of the RF and Meas signals. Two markers identify the start points of the stable
signals. An equation for Delay is defined to calculate the difference in time domain
between the two markers. The value of Delay is displayed in a table to indicate the delay
caused by the DUT.
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 RF Envelope Measurement Results

 

 Power Measurement

 The power measurement measures the CCDF (complementary cumulative distribution
function) curves of the transmitter (CCDF is not defined in 3GPP specifications). The CCDF
and the peak-to-average ratio is calculated for the 3GPP FDD RF signal.

Two kinds of signals are tested: the RF signal which does not go through the DUT; and,
the Meas signal which does go through the DUT and may contain a few microseconds of
delay, some noise, and nonlinearity.

The data display contains three pages. The following figure shows peak power, mean
power and peak-to-mean ratio of RF and Meas signals.

 

 RF and Meas Signal Power Ratios

The following figure shows two CCDF curves of RF and Meas signals. The
3GPPFDD_UE_TX_Power Equations page includes two equations that are defined to
calculate peak-to-mean ratio of the RF and Meas signals.
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 CCDF Curves

 

 ACLR Measurement

 This measurement is used to test adjacent channel leakage power ratio (ACLR) defined in
3GPP TS 25.101, section 6.6.2.2.

ACLR is the ratio of the RRC filtered mean power centered on the assigned channel
frequency to the RRC filtered mean power centered on an adjacent channel frequency.
Two kinds of signals are tested: the RF signal which does not go through the DUT; and,
the Meas signal which does go through DUT and may contain a few of microseconds of
delay, some noise and nonlinearity.

In the data display, measurement results are automatically compared with pass/fail
criteria defined in 3GPP TS 25.101, table 6.11. The comparison results are displayed on
the 3GPPFDD_UE_TX_ACLR Table page (the following figure).

The data display contains three pages. The 3GPPFDD_UE_TX_ACLR Table page (the
following figure) shows adjacent channel power and adjacent power ratio of the RF and
Meas signals.
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 ACLR Measurement Results

The 3GPPFDD_UE_TX_ACLR Figures page (the following figure) shows the spectrum of the
main channel and adjacent channels of the RF and Meas signals. The
3GPPFDD_UE_TX_ACLR Equations page includes several equations that are defined to
calculate adjacent channel power and adjacent channel power ratio of the RF and Meas
signals.
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 ACLR Spectrums

 

 ACLR Due to Switching Transient Measurement

 This ACLR_ST measurement is used to test adjacent channel leakage power ratio (ACLR)
in the presence of switching transients, defined in 3GPP TS 25.101, section 6.6.2.2, Note
1.

ACLR is the ratio of the RRC filtered mean power centered on the assigned channel
frequency to the RRC filtered mean power centered on an adjacent channel frequency.
Two kinds of signal are tested: the RF signal which does not go through the DUT; and, the
Meas signal which does go through the DUT and may contain a few microseconds of delay,
some noise, and nonlinearity.

In the data display, the measurement results are automatically compared with pass/fail
criteria defined in 3GPP TS 25.101, table 6.11, and the comparison results are displayed
on the 3GPPFDD_UE_TX_ACLR_ST Table page (the following figure).

The data display contains two pages. The 3GPPFDD_UE_TX_ACLR_ST Table page (the
following figure) shows adjacent channel power and adjacent power ratio of the RF and
Meas signals. The 3GPPFDD_UE_TX_ACLR_ST Equations page includes several equations
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that are defined to calculate adjacent channel power and adjacent channel power ratio of
the RF and Meas signals.

 

 ACLR_ST Measurement Results

 

 Occupied Bandwidth Measurement

 The occupied bandwidth (OBW) measurement is defined in 3GPP TS 25.104, section
6.6.1. OBW is a measure of the bandwidth containing 99% of the total integrated power
for transmitted spectrum and is centered on the assigned channel frequency. The occupied
channel bandwidth must be less than 5 MHz based on a chip rate of 3.84 Mcps.

Two kinds of signals are tested: the RF signal which does not go through the DUT; and,
the Meas signal which does go through the DUT and may contain a few microseconds of
delay, some noise, and nonlinearity.

In the data display, measurement results are automatically compared with pass/fail
criteria defined in 3GPP TS 25.101, section 6.6.1, and the comparison results are
displayed on 3GPPFDD_UE_TX_OBW Table page (the following figure).

At the top of each page, an identical table contains basic measurement parameters. The
3GPPFDD_UE_TX_OBW Table page (the following figure) shows the resolution bandwidth
and the occupied bandwidth of the RF and Meas signals. Adjust the markers using the
keyboard arrow keys until the Lower Side and the Higher Side power ratio equals 0.5%.
The 3GPPFDD_UE_TX_OBW Table page (the following figure) shows the equations used to
calculate the occupied bandwidth, and the criteria used to determine if the results pass or
not.
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 Occupied Bandwidth Measurement Results

The 3GPPFDD_UE_TX_OBW Figures page (the following figure) shows the spectrum of the
RF and Meas signals with two markers placed on each spectrum.
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 Occupied Bandwidth Signal Spectrums

 

 CDP Measurement

 Code domain power (CDP) is a measure of power distribution on code domain (not
defined in the 3GPP specifications).

The CDP is calculated by projecting the power onto the code domain at a specified spread
factor (256). The CDP for every code in the domain is defined as the ratio of the mean
power of the projection onto that code, to the mean power of the composite reference
waveform. The measurement interval is one timeslot. Two kinds of signals are tested: the
RF signal which does not go through the DUT, and the Meas signal which does go through
the DUT and may contain a few microseconds of delay, some noise, and nonlinearity.

Results are shown in the following figure.



Advanced Design System 2011.01 - 3GPP FDD Wireless Test Benches

129

 

 CDP Measurement Results

 

 PCDE Measurement

 This measurement is used to test peak code domain error (PCDE) defined in 3GPP TS
25.101, section 6.8.3.

PCDE is calculated by projecting the power of the error vector onto the code domain at a
specified spread factor. The code domain error for every code in the domain is defined as
the ratio of the mean power of the projection onto that code, to the mean power of the
composite reference waveform. This ratio is expressed in dB. The PCDE is defined as the
maximum value for the code domain error for all codes. The measurement interval is one
timeslot. Two kinds of signals are tested: the RF signal which does not go through the
DUT, and the Meas signal which does go through the DUT and may contain a few
microseconds of delay, some noise and nonlinearity.

In the data display, the measurement results are compared automatically with pass/fail
criteria defined in 3GPP TS 25.101, section 6.8.3.1. Comparison results are displayed on
the 3GPPFDD_UE_TX_PCDE Table page (the following figure).

The data display contains three pages. The 3GPPFDD_UE_TX_PCDE Table page (the
following figure) shows the peak code domain error of the RF and Meas signals.
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 PCDE Measurement Results

The 3GPPFDD_UE_TX_PCDE Figures page (the following figure) shows the code domain
error of the RF and Meas signals; markers indicate the peak values. The
3GPPFDD_UE_TX_PCDE Equations page shows the equations used to calculate peak code
domain error, and the criteria used to determine if the results pass or not.

 

 PCDE Waveforms

 

 EVM Measurement

 This measurement is used to test error vector magnitude (EVM) defined in 3GPP TS
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25.101, section 6.8.2.

EVM is a measure of the difference between the theoretical waveform and a modified
version of the measured waveform. This difference is called the error vector. The
measured waveform is modified by first passing it through a matched Root Raised Cosine
filter with a bandwidth of 3.84MHz and 0.22 roll-off. The waveform is then further
modified by selecting the frequency, absolute phase, absolute amplitude, and chip clock
timing so as to minimize the error vector. The EVM result is defined as the root of the
mean error vector power though the mean reference signal power expressed as a percent.
The EVM cannot exceed 17.5%.

The data display contains two pages. At the top of each page, an identical table contains
some basic measurement parameters. The 3GPPFDD_UE_TX_EVM Table page (the
following figure) shows the EVM of the RF and Meas signals. The 3GPPFDD_UE_TX_EVM
Equations page shows the criteria used to determine if the results pass or not.

 

 EVM Measurement Results

 

 Test Bench Variables for Data Displays

 The following tables identify the reference variables used to set up this test bench:

 Test Bench Constants Used to Set up 3GPP FDD User Equipment Signal

Constant Value

SamplesPerChip 8

ChipRate 3.84
MHz

ChipsPerSlot 2560

SlotsPerFrame 15
 Test Bench Equations Derived from Test Bench Parameters and Exported to the Data Display
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Data Display Parameter Equation with Test Bench Parameters

RF_FSource FSource

RF_Power_dBm 10*log10(SourcePower)+30

RF_R SourceR

TimeStep 1/(ChipRate*SamplesPerChip)
This is the test bench simulation time
step

SlotTime ChipsPerSlot*SamplesPerChip*TimeStep
This is the time duration of each slot

FrameTime SlotTime*SlotsPerFrame

Meas_FMeasurement FMeasurement

Meas_R MeasR
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 Baseline Performance
Test Computer Configuration

Pentium IV 2.4 GHz, 512 MB RAM, Red Hat Linux 7.3
Conditions

Measurements made with default test bench settings.
RF DUT is an RF system behavior component.
The number of time points in one slot can be calculated by SamplesPerChip
times ChipsPerSlot.
ChipRate = 3.84 MHz
SamplesPerChip = 8
ChipsPerSlot = 2560
Resultant WTB_TimeStep = 32.6 nsec; SlotTime = 666.7 µ time points per slot
= 20480

Simulation times and memory requirements
3GPPFDD_UE_TX Measurement Slots Measured Simulation Time

(sec)
ADS Processes (MB)

RF_Envelope 1 9 207

Power 1 7 205

ACLR 1 91 205

ACLR_ST 1 47 209

Occupied BW 1 9 212

CDP 1 101 211

PCDE 1 436 212

EVM 1 434 205

 

 Expected ADS Performance

Expected ADS performance is the combined performance of the baseline test bench and
the RF DUT Circuit Envelope simulation with the same signal and number of time points.
For example, if the RF DUT performance with Circuit Envelope simulation alone takes 2
hours and consumes 200 MB of memory (excluding the memory consumed by the core
ADS product), then add these numbers to the Baseline Performance numbers to
determine the expected ADS performance. This is valid only if the full memory consumed
is from RAM. If RAM is less, larger simulation times may result due to increased disk
access time for swap memory usage.
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http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25212-390.zip
3GPP Technical Specification TS 25.213, "Spreading and modulation (FDD)" Release3.
1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25213-370.zip
3GPP Technical Specification TS 25.101, "UE Radio transmission and reception (FDD)"4.
Release 1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25101-3a0.zip
3GPP Technical Specification TS 34.121, "Terminal Conformance Specification, Radio5.
Transmission and Reception (FDD)" Release 1999.
http://www.3gpp.org/ftp/Specs/2002-03/R1999/34_series/34121-380.zip

Setting up a Wireless Test Bench Analysis in the Wireless Test Bench Simulation
documentation explains how to use test bench windows and dialogs to perform analysis
tasks.

Setting Circuit Envelope Analysis Parameters in the Wireless Test Bench Simulation
documentation explains how to set up circuit envelope analysis parameters such as
convergence criteria, solver selection, and initial guess.

Setting Automatic Behavioral Modeling Parameters in the Wireless Test Bench Simulation
documentation to learn how to improve simulation speed.
 

http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25211-3a0.zip
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25211-3a0.zip
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25212-390.zip
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25212-390.zip
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25213-370.zip
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25213-370.zip
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25101-3a0.zip
http://www.3gpp.org/ftp/Specs/2002-03/R1999/25_series/25101-3a0.zip
http://www.3gpp.org/ftp/Specs/2002-03/R1999/34_series/34121-380.zip
http://www.3gpp.org/ftp/Specs/2002-03/R1999/34_series/34121-380.zip
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 Measurement Results for Expressions
for 3GPP FDD Wireless Test Benches
Measurement results from a wireless test bench have associated names that can be used
in Expressions. Those expressions can further be used in specifying goals for Optimization
and Monte Carlo/Yield analysis. For details on using expressions, see the Measurement
Expressions (expmeas) documentation. For details on setting analysis goals using
Optimization and Monte Carlo/Yield analysis, see the Tuning, Optimization, and Statistical
Design (optstat) documentation.

You can use an expression to determine the measurement result independent variable
name and its minimum and maximum values. The following example expressions show
how to obtain these measurement details where MeasResults is the name of the
measurement result of interest:

The Independent Variable Name for this measurement result is obtained by using the
expression
indep(MeasResults)

The Minimum Independent Variable Value for this measurement result is obtained by
using the expression
min(indep(MeasResults))

The Maximum Independent Variable Value for this measurement result is obtained by
using the expression
max(indep(MeasResults))

The following tables list the measurement result names and independent variable name
for each test bench measurement. Expressions defined in a MeasEqn block must use the
full Measurement Results Name listed. Expressions used in the Data Display may omit the
leading test bench name. You can also locate details on the measurement result minimum
and maximum independent variable values by

Referring to the measurement parameter descriptions when they are available (not
all measurement parameter descriptions identify these minimum and maximum
values).
Observing the minimum and maximum independent variable values in the Data
Display for the measurement.

 3GPPFDD_BS_TX Measurement Results
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Measurement Results Name Independent Variable Name

Envelope

3GPPFDD_BS_TX.RF_V time

3GPPFDD_BS_TX.Meas_V time

Power

3GPPFDD_BS_TX.RF_Power.CCDF.CCDF Index

3GPPFDD_BS_TX.RF_Power.CCDF.MeanPower_dBm Index

3GPPFDD_BS_TX.RF_Power.CCDF.PeakPower_dBm Index

3GPPFDD_BS_TX.RF_Power.CCDF.SignalRange_dB Index

3GPPFDD_BS_TX.Meas_Power.CCDF.CCDF Index

3GPPFDD_BS_TX.Meas_Power.CCDF.MeanPower_dBm Index

3GPPFDD_BS_TX.Meas_Power.CCDF.PeakPower_dBm Index

3GPPFDD_BS_TX.Meas_Power.CCDF.SignalRange_dB Index

ACLR

3GPPFDD_BS_TX.RF_ACLR.Spec_Out_L10 freq

3GPPFDD_BS_TX.RF_ACLR.Spec_Out_L5 freq

3GPPFDD_BS_TX.RF_ACLR.Spec_Out_Main freq

3GPPFDD_BS_TX.RF_ACLR.Spec_Out_U5 freq

3GPPFDD_BS_TX.RF_ACLR.Spec_Out_U10 freq

3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_L10 freq

3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_L5 freq

3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_Main freq

3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_U5 freq

3GPPFDD_BS_TX.Meas_ACLR.Spec_Out_U10 freq

Occupied Bandwidth

3GPPFDD_BS_TX.RF_OBW.Spec_Out freq

3GPPFDD_BS_TX.Meas_OBW.Spec_Out freq

CDP

3GPPFDD_BS_TX.RF_CDP.CodeDomainPwr.CDP_CodeIndex Index

3GPPFDD_BS_TX.RF_CDP.CodeDomainPwr.CodeDomainPwr Index

3GPPFDD_BS_TX.Meas_CDP.CodeDomainPwr.CDP_CodeIndex Index

3GPPFDD_BS_TX.Meas_CDP.CodeDomainPwr.CodeDomainPwr Index

PCDE

3GPPFDD_BS_TX.RF_PCDE.CodeDomainErr.CDE_CodeIndex Index

3GPPFDD_BS_TX.RF_PCDE.CodeDomainErr.I_CDE Index

3GPPFDD_BS_TX.RF_PCDE.CodeDomainErr.Q_CDE Index

3GPPFDD_BS_TX.Meas_PCDE.CodeDomainErr.CDE_CodeIndex Index

3GPPFDD_BS_TX.Meas_PCDE.CodeDomainErr.I_CDE Index

3GPPFDD_BS_TX.Meas_PCDE.CodeDomainErr.Q_CDE Index

EVM

3GPPFDD_BS_TX.RF_EVM.EVM.EVM Index

3GPPFDD_BS_TX.Meas_EVM.EVM.EVM Index
 3GPPFDD_UE_TX Measurement Results
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Measurement Results Name Independent Variable Name

Envelope

3GPPFDD_UE_TX.RF_V time

3GPPFDD_UE_TX.Meas_V time

Power

3GPPFDD_UE_TX.RF_Power.CCDF.CCDF Index

3GPPFDD_UE_TX.RF_Power.CCDF.MeanPower_dBm Index

3GPPFDD_UE_TX.RF_Power.CCDF.PeakPower_dBm Index

3GPPFDD_UE_TX.RF_Power.CCDF.SignalRange_dB Index

3GPPFDD_UE_TX.Meas_Power.CCDF.CCDF Index

3GPPFDD_UE_TX.Meas_Power.CCDF.MeanPower_dBm Index

3GPPFDD_UE_TX.Meas_Power.CCDF.PeakPower_dBm Index

3GPPFDD_UE_TX.Meas_Power.CCDF.SignalRange_dB Index

ACLR

3GPPFDD_UE_TX.RF_ACLR.Spec_Out_L10 freq

3GPPFDD_UE_TX.RF_ACLR.Spec_Out_L5 freq

3GPPFDD_UE_TX.RF_ACLR.Spec_Out_Main freq

3GPPFDD_UE_TX.RF_ACLR.Spec_Out_U5 freq

3GPPFDD_UE_TX.RF_ACLR.Spec_Out_U10 freq

3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_L10 freq

3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_L5 freq

3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_Main freq

3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_U5 freq

3GPPFDD_UE_TX.Meas_ACLR.Spec_Out_U10 freq

ACLR_SwitchingTransients

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.L10.AverageBlockPower Index

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.L10.AverageTotalPower Index

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.L5.AverageBlockPower Index

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.L5.AverageTotalPower Index

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.Main.AverageBlockPower Index

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.Main.AverageTotalPower Index

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.U5.AverageBlockPower Index

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.U5.AverageTotalPower Index

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.U10.AverageBlockPower Index

3GPPFDD_UE_TX.RF_ACLR_SwitchingTransients.U10.AverageTotalPower Index

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.L10.AverageBlockPower Index

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.L10.AverageTotalPower Index

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.L5.AverageBlockPower Index

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.L5.AverageTotalPower Index

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.Main.AverageBlockPower Index

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.Main.AverageTotalPower Index

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.U5.AverageBlockPower Index

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.U5.AverageTotalPower Index



Advanced Design System 2011.01 - 3GPP FDD Wireless Test Benches

138

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.U10.AverageBlockPower Index

3GPPFDD_UE_TX.Meas_ACLR_SwitchingTransients.U10.AverageTotalPower Index

Occupied Bandwidth

3GPPFDD_UE_TX.RF_OccupiedBW.Spec_Out freq

3GPPFDD_UE_TX.Meas_OccupiedBW.Spec_Out freq

CDP

3GPPFDD_UE_TX.RF_CDP.CodeDomainPwr.CDP_CodeIndex Index

3GPPFDD_UE_TX.RF_CDP.CodeDomainPwr.CodeDomainPwr Index

3GPPFDD_UE_TX.Meas_CDP.CodeDomainPwr.CDP_CodeIndex Index

3GPPFDD_UE_TX.Meas_CDP.CodeDomainPwr.CodeDomainPwr Index

PCDE

3GPPFDD_UE_TX.RF_PCDE.CodeDomainErr.CDE_CodeIndex Index

3GPPFDD_UE_TX.RF_PCDE.CodeDomainErr.I_CDE Index

3GPPFDD_UE_TX.RF_PCDE.CodeDomainErr.Q_CDE Index

3GPPFDD_UE_TX.Meas_PCDE.CodeDomainErr.CDE_CodeIndex Index

3GPPFDD_UE_TX.Meas_PCDE.CodeDomainErr.I_CDE Index

3GPPFDD_UE_TX.Meas_PCDE.CodeDomainErr.Q_CDE Index

EVM

3GPPFDD_UE_TX.RF_EVM.EVM.EVM Index

3GPPFDD_UE_TX.Meas_EVM.EVM.EVM Index
 3GPPFDD_BS_RX Measurement Results

Measurement Results Name Independent Variable Name

3GPPFDD_BS_RX.Meas_BER.DCCHbits Index

3GPPFDD_BS_RX.Meas_BER.DCCH_BER Index

3GPPFDD_BS_RX.Meas_BER.DCCH_BLER Index

3GPPFDD_BS_RX.Meas_BER.DPDCHbits Index

3GPPFDD_BS_RX.Meas_BER.DPDCH_BER Index

3GPPFDD_BS_RX.Meas_BER.DTCHbits Index

3GPPFDD_BS_RX.Meas_BER.DTCH_BER Index

3GPPFDD_BS_RX.Meas_BER.DTCH_BLER Index

3GPPFDD_BS_RX.Meas_BER.RefDCCHbits Index

3GPPFDD_BS_RX.Meas_BER.RefDPDCHbits Index

3GPPFDD_BS_RX.Meas_BER.RefDTCHbits Index
 3GPPFDD_UE_RX Measurement Results
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Measurement Results Name Independent Variable Name

3GPPFDD_UE_RX.Meas_Measurement.DCCHbits Index

3GPPFDD_UE_RX.Meas_Measurement.DCCH_BER Index

3GPPFDD_UE_RX.Meas_Measurement.DCCH_BLER Index

3GPPFDD_UE_RX.Meas_Measurement.DPCHbits Index

3GPPFDD_UE_RX.Meas_Measurement.DPCH_BER Index

3GPPFDD_UE_RX.Meas_Measurement.DTCHbits Index

3GPPFDD_UE_RX.Meas_Measurement.DTCH_BER Index

3GPPFDD_UE_RX.Meas_Measurement.DTCH_BLER Index

3GPPFDD_UE_RX.Meas_Measurement.RefDCCHbits Index

3GPPFDD_UE_RX.Meas_Measurement.RefDPCHbits Index

3GPPFDD_UE_RX.Meas_Measurement.RefDTCHbits Index
 3GPPFDD_RF_PAE Measurement Results

Measurement Results Name Independent Variable Name

RF_PAE.DCPower_W time

RF_PAE.FrameMarker time

RF_PAE.MeasGate time

RF_PAE.PAE_pct time

RF_PAE.RFAddedPower_W time

RF_PAE.RFPin_W time

RF_PAE.RFPout_W time

RF_PAE.RF_in time

RF_PAE.RF_out time
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 RF DUT Limitations for 3GPP FDD
Wireless Test Benches
This section describes test bench use with typical RF DUTs, improving test bench
performance when certain RF DUT types are used, and improving simulation fidelity. Two
sections regarding special attention for Spectum and EVM transmission measurements is
also included.

The RF DUT, in general, may be a circuit design with any combination and quantity of
analog and RF components, transistors, resistors, capacitors, etc. suitable for simulation
with the Agilent Circuit Envelope simulator. More complex RF circuits will take more time
to simulate and will consume more memory.

Test bench simulation time and memory requirements can be considered to be the
combination of the requirements for the baseline test bench measurement with the
simplest RF circuit plus the requirements for a Circuit Envelope simulation for the RF DUT
of interest.

An RF DUT connected to a wireless test bench can generally be used with the test bench
to perform default measurements by setting the test bench Required Parameters. Default
measurement parameter settings can be used (exceptions described below), for a typical
RF DUT that:

Requires an input (RF) signal with constant RF carrier frequency.
The test bench RF signal source output does not produce an RF signal whose RF
carrier frequency varies with time. However, the test bench will support an output
(RF) signal that contains RF carrier phase and frequency modulation as can be
represented with suitable I and Q envelope variations on a constant RF carrier
frequency.
Produces an output (Meas) signal with constant RF carrier frequency.
The test bench input (Meas) signal must not contain a carrier frequency whose
frequency varies with time. However, the test bench will support an input (Meas)
signal that contains RF carrier phase noise or contains time varying Doppler shifts of
the RF carrier. These signal perturbations are expected to be represented with
suitable I and Q envelope variations on a constant RF carrier frequency.
Requires an input (RF) signal from a signal generator with a 50-ohm source
resistance. Otherwise, set the SourceR parameter value in the Basic Parameters tab.
Requires an input (RF) signal with no additive thermal noise (TX test benches) or
source resistor temperature set to 16.85o C (RX test benches). Otherwise, set the
SourceTemp (TX and RX test benches) and EnableSourceNoise (TX test benches)
parameters in the Basic Parameters tab.
Requires an input (RF) signal with no spectrum mirroring. Otherwise, set the
MirrorSourceSpectrum parameter value in the Basic Parameters tab.
Produces an output (Meas) signal that requires a 50-ohm external load resistance.
Otherwise, set the MeasR parameter value in the Basic Parameters tab.
Produces an output (Meas) signal with no spectrum mirroring. Otherwise, set the
MirrorMeasSpectrum parameter value in the Basic Parameters tab.
Relies on the test bench for any measurement-related bandpass signal filtering of the
RF DUT output (Meas) signal.

When the RF DUT contains a bandpass filter with bandwidth that is on the order
of the test bench receiver system (~1 times the test bench receiver bandwidth)
and the user wants a complete characterization of the RF DUT filter, the default
time CE_TimeStep must be set smaller.
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When the RF DUT bandpass filter is much wider than the test bench receiver
system (>2 times the test bench receiver bandwidth), the user may not want to
use the smaller CE_TimeStep time step to fully characterize it because the user
knows the RF DUT bandpass filter has little or no effect in the modulation
bandwidth in this case.

 

 Improving Test Bench Performance

This section provides information regarding improving test bench performance when
certain RF DUT types are used.

Analog/RF models (TimeDelay and all transmission line models) used with Circuit
Envelope simulation that perform linear interpolation on time domain waveforms for
modeling time delay characteristics that are not an integer number of CE_TimeStep
units. Degradation is likely in some measurements, especially EVM.
This limitation is due to the linear interpolation between two successive simulation
time points, which degrades waveform quality and adversely affects EVM
measurements.
To avoid this kind of simulator-induced waveform quality degradation: avoid use of
Analog/RF models that rely on linear interpolation on time domain characteristics; or,
reduce the test bench CE_TimeStep time step by a factor of 4 below the default
CE_TimeStep (simulation time will be 4 times longer).
Analog/RF lumped components (R, L, C) used to provide bandpass filtering with a
bandwidth as small as the wireless signal RF information bandwidth are likely to
cause degradation in some measurements, especially Spectrum. These circuit filters
require much smaller CE_TimeStep values than would otherwise be required for RF
DUT circuits with broader bandwidths.
This limitation is due to the smaller Circuit Envelope simulation time steps required to
resolve the differential equations for the L, C components when narrow RF
bandwidths are involved. Larger time steps degrade the resolution of the simulated
bandpass filtering effects and do not result in accurate frequency domain
measurements, especially Spectrum and EVM measurements (when the wireless
technology is sensitive to frequency domain distortions).
To determine that your lumped component bandwidth filter requires smaller
CE_TimeStep, first characterize your filter with Harmonic Balance simulations over
the modulation bandwidth of interest centered at the carrier frequency of interest.
Though it is difficult to identify an exact guideline on the Circuit Envelope time step
required for good filter resolution, a reasonable rule is to set the CE_TimeStep to
1/(double-sided 3dB bandwidth)/32.
To avoid this kind of simulator-induced waveform quality degradation, avoid the use
of R, L, C lumped filters with bandwidths as narrow as the RF signal information
bandwidth, or reduce the CE_TimeStep.
Analog/RF data-based models (such as S-parameters and noise parameters in S2P
data files) used to provide RF bandpass filtering with a bandwidth as small as 1.5
times the wireless signal RF information bandwidth are likely to cause degradation in
some measurements, especially EVM.
This limitation is due to causal S-parameter data about the signal carrier frequency
requiring a sufficient number of frequency points within the modulation bandwidth;
otherwise, the simulated data may cause degraded signal waveform quality. In
general, there should be more than 20 frequency points in the modulation
bandwidth; more is required if the filter that the S-parameter data represents has
fine-grain variations at small frequency steps.
To avoid this kind of simulator-induced waveform quality degradation, avoid the use
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of data-based models with bandwidths as narrow as the RF signal information
bandwidth, or increase the number of frequency points in the data file within the
modulation bandwidth and possibly also reduce the CE_TimeStep simulation time
step.
An additional limitation exists when noise data is included in the data file. Circuit
Envelope simulation technology does not provide frequency-dependent noise within
the modulation bandwidth for this specific case when noise is from a frequency
domain data file. This may result in output noise power that is larger than expected;
if the noise power is large enough, it may cause degraded signal waveform quality.
To avoid this kind of simulator-induced waveform quality degradation avoid the use
of noise data in the data-based models or use an alternate noise model.

 

 Improving Simulation Fidelity

Some RF circuits will provide better Circuit Envelope simulation fidelity if the CE_TimeStep
is reduced.

In general, the default setting of the test bench SamplesPerChip provides adequate
wireless signal definition and provides the WTB_TimeStep default value.
Set CE_TimeStep = 1/(3.84e6/SamplesPerChip×N)

where N is an integer ≥ 1
When CE_TimeStep is less than the WTB_TimeStep (i.e., N>1), the RF signal to the
RF DUT is automatically upsampled from the WTB_TimeStep and the RF DUT output
signal is automatically downsampled back to the WTB_TimeStep. This sampling
introduces a time delay to the RF DUT of 10×WTB_TimeStep and a time delay of the
measured RF DUT output signal of 20×WTB_TimeStep relative to the measured RF
signal sent to the RF DUT prior to its upsampling.

 

 Special Attention for Spectrum Measurements

The Spectrum Measurement spectrum may have a mask against which the spectrum must
be lower in order to pass the wireless specification. The Spectrum measurement itself is
based on DSP algorithms that result in as much as 15 dB low-level spectrum variation at
frequencies far from the carrier.

To reduce this low-level spectrum variation, a moving average can be applied to the
spectrum using the moving_average(<data>, 20) measurement expression for a 20-point
moving average. This will give a better indication of whether the measured signal meets
the low-level spectrum mask specification at frequencies far from the carrier.

 

 Special Attention for EVM Measurements

For the EVM measurement, the user can specify a start time. The EVM for the initial
wireless segment may be unusually high (due to signal startup transient effects or other
reasons) that cause a mis-detected first frame that the user does not want included in the
RF DUT EVM measurement.

To remove the degraded initial burst EVM values from the RF DUT EVM measurement, set
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the EVM_Start to a value greater than or equal to the RF DUT time delay characteristic.
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